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The information provided in this documentation contains general descriptions and/or 
technical characteristics of the performance of the products contained herein. This 
documentation is not intended as a substitute for and is not to be used for 
determining suitability or reliability of these products for specific user applications. It 
is the duty of any such user or integrator to perform the appropriate and complete 
risk analysis, evaluation and testing of the products with respect to the relevant 
specific application or use thereof. Neither Schneider Electric nor any of its affiliates 
or subsidiaries shall be responsible or liable for misuse of the information contained 
herein. If you have any suggestions for improvements or amendments or have found 
errors in this publication, please notify us. 

No part of this document may be reproduced in any form or by any means, electronic 
or mechanical, including photocopying, without express written permission of 
Schneider Electric.

All pertinent state, regional, and local safety regulations must be observed when 
installing and using this product. For reasons of safety and to help ensure 
compliance with documented system data, only the manufacturer should perform 
repairs to components.

When devices are used for applications with technical safety requirements, the 
relevant instructions must be followed. 

Failure to use Schneider Electric software or approved software with our hardware 
products may result in injury, harm, or improper operating results.

Failure to observe this information can result in injury or equipment damage.

© 2012 Schneider Electric. All rights reserved.
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Safety Information
Important Information

NOTICE

Read these instructions carefully, and look at the equipment to become familiar with 
the device before trying to install, operate, or maintain it. The following special 
messages may appear throughout this documentation or on the equipment to warn 
of potential hazards or to call attention to information that clarifies or simplifies a 
procedure.
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PLEASE NOTE

Electrical equipment should be installed, operated, serviced, and maintained only by 
qualified personnel. No responsibility is assumed by Schneider Electric for any 
consequences arising out of the use of this material.

A qualified person is one who has skills and knowledge related to the construction 
and operation of electrical equipment and its installation, and has received safety 
training to recognize and avoid the hazards involved.
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About the Book
At a Glance

Document Scope

This document provides general information about SoMachine software.

Validity Note

This document has been updated with the release of SoMachine V3.1.

User Comments

We welcome your comments about this document. You can reach us by e-mail at 
techcomm@schneider-electric.com.
04/2012 9



10 04/2012



04/2012
I

SoMachine

General Introduction

 04/2012
General Introduction
11



General Introduction

12 04/2012



04/2012
1

SoMachine

General Introduction to SoMachine

 04/2012
General Introduction to 
SoMachine
Overview

This chapter provides an overview of the specific functions provided by SoMachine. 

What’s in this Chapter?

This chapter contains the following topics:

Topic Page

What is SoMachine 14

Overview 17

Machine Transparency 19
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General Introduction to SoMachine
What is SoMachine

Presentation

SoMachine is a professional, efficient and open Original Equipment Manufacturers 
(OEM) software solution that aides you in the developing, configuring and 
commissioning of the entire machine in a single environment (including logic, motor 
control, HMI and related network automation functions). 

SoMachine allows you to program and commission the entire range of elements in 
the Schneider Electric Flexible Machine Control offer, and helps you to achieve the 
most optimized control solution for most machine requirements.

Schneider Electric Flexible Machine Control

Schneider Electric Flexible Machine Control is the comprehensive solution-oriented 
offer for OEMs that includes the following elements:

1 software environment
SoMachine

4 hardware control platform types
HMI controller
logic controller
motion controller
drive controller

other devices
HMI
speed drives
distributed I/O modules, etc.
14 04/2012



General Introduction to SoMachine
SoMachine version 3.1 integrates:
HMI controllers

Magelis XBTGC HMI controller
Magelis XBTGT/GK CANopen HMI controller

Logic controllers
Modicon M238
Modicon M258

Motion controllers
Modicon LMC058

Drive controllers
Altivar ATV IMC

HMI Magelis graphic panels
Magelis XBTGT
Magelis XBTGK
Magelis XBTGH
Magelis GTO
Magelis STU
Magelis STO (HMI STO 511 / 512 / 531 / 532)

Other HMI graphic panels are supported via the Modbus connection which do not 
support the SoMachine protocol.

Features and Functions

SoMachine provides the following features and functions: 
entire range of IEC 61131-3 languages
integrated fieldbus configurators
expert diagnostics and debugging
visualization screen
upgrading software via the website www.schneider-electric.com
integrated function block finder to simplify programming
integrated OPC server
optional installation of the HMI application development tool Vijeo-Designer

Simplifying the User Workflow

With SoMachine you can design a complete solution with just:
1 software
1 project file
1 cable connection
1 download
04/2012 15



General Introduction to SoMachine
Dedicated OEM Libraries

SoMachine integrates tested, validated, documented and supported expert 
application libraries dedicated to many OEM applications. A simple configuration 
methodology speeds up design, commissioning, installation and troubleshooting.

The following libraries are provided by SoMachine version 3.1:
Motion & Drives libraries for motion & drives devices control via CANopen
Toolbox library that offers a set of functions for programming, remote devices 
control and automation functions (for example closed loop control)

The SoMachine Solution Extension provides additional libraries for the following 
applications running with S-type controllers:

Packaging
Hoisting
Conveying

For further information on differences between SoMachine version 3.1 and the 
SoMachine Solution Extension, refer to the SoMachine Product Offer chapter 
(see page 37). 
16 04/2012



General Introduction to SoMachine
Overview

Visual Graphic User Interface

Navigation within SoMachine is intuitive and highly visual. 

Presentation is optimized in such a way that selecting the development stage of the 
desired project makes the appropriate tools available. 

The user interface provides the following advantages:
it helps to ensure that nothing is omitted
it suggests the tasks to be performed throughout the project development cycle
its workspace has been streamlined so that only those items necessary and 
relevant to the current task are featured, avoiding any superfluous information

Learning Centre

The Home menu includes a Learning Centre that provides the following tools to get 
started with SoMachine. 

An animated file briefly explains the SoMachine interface and concept.
An e-learning, interactive with the user, allows to run a self-training about 
SoMachine.
A third section gives access to several documented SoMachine programming 
examples.

Projects Management

The implemented project management principle allows you to browse the existing 
projects without the need to open them before selection. 

You can create new projects either from scratch or on the following bases:
using tested validated and documented architectures
using the provided examples
using an existing project 

SoMachine provides quick access to the most recently-used projects.

Project Properties

SoMachine provides the possibility to add the following items to each project:
additional textual information
attach documents
attach your individual customer picture
attach a configuration picture

Configuration

The SoMachine graphical user interface allows you to easily build your architecture 
and configure the devices of your architecture.
04/2012 17



General Introduction to SoMachine
Programming

Programming is an essential step. It must be carried out carefully to be as efficient 
as possible.

Advanced control and HMI functions cover the needs of an OEM engineer in terms 
of creating the control and visualization system. Design and functional tests are 
possible at any moment by quickly simulating the control or HMI system.

Commissioning

SoMachine provides a Commissioning screen for easy and fast diagnostics.

It presents the online state of the architecture in a graphical configuration editor that 
indicates whether you are logged into the displayed devices, as well as if they are in 
run or stop mode.

Documentation

Because a printed file of the project is an important element, SoMachine lets you 
build and customize a project report by executing the following steps:

select the items to be included in the report
organize the sections
define the page layout
launch the printing process
18 04/2012
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Machine Transparency

SoMachine Protocol

The SoMachine protocol is the preferred protocol providing a transparent access to 
your machine’s controllers and HMIs.

The SoMachine protocol is used for any data exchange
between the SoMachine software (PC) and the runtime systems (controller, HMI)
between controllers and integrated HMIs supporting SoMachine protocol

This leads to the following advantages that will be described below:
a single cable connection to 1 HMI or controller of your machine provides access 
to any other HMI or controller of the machine
variables defined once are available to any other HMI or controller in the machine

Single Cable Connection

The transparent SoMachine protocol allows you to access any HMI or controller that 
is part of your machine by connecting your SoMachine PC to only 1 device on your 
machine. The connection will then be routed through any connected device.

This single connection to the machine provides a gain in simplicity by transferring 
data using the same cable from the PC to the machine.

1 connection between SoMachine PC and controller
2 alternative connection between SoMachine PC and HMI
3 logic controller
4 HMI
5 serial line connection between controller and HMI

The above figure illustrates the equivalent access. This means that downloading 
and commissioning to the controller can be performed in 2 different ways:

directly connecting the SoMachine PC to the controller which, in turn, routes the 
information to the HMI
or
connecting the SoMachine PC to the HMI which, in turn, routes the information to 
the controller.

2
4

5

3

1
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General Introduction to SoMachine
One-Shot Variable Definition

The transparent SoMachine protocol allows you to define variables only once in the 
project and to make them available to any other HMI or controller by a publish-
subscriber mechanism based on symbolic names. Once the variables have been 
published, they may be subscribed by other HMIs or controllers without the need to 
re-enter the variable definition.

This provides you the following key advantages:
single definition of variables shared between the controller and the HMI
publishing and subscribing variables by simple selection
variable exchange definition independent of the medium (serial line, etc.)

Transparent Access to Fieldbus Devices

The single connection between the PC and the controller provides pure transparent 
access to each device connected on CANopen. From the SoMachine unique user 
interface you can set-up remote devices offline and tune them online.
20 04/2012
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What’s in this Part?

This part contains the following chapters:

Chapter Chapter Name Page

2 System Requirements 23

3 Installation and Registration of SoMachine 25

4 SoMachine Product Offer 37
21
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System Requirements

Overview

The following paragraphs describe the hardware and software requirements of the 
PC for SoMachine installation should meet. 

Hardware Requirements

The PC for SoMachine installation must meet the following hardware requirements:

Equipment Minimum Recommended

processor Pentium V, 1.8 GHz, 
Pentium M, 1.0 GHz 
or equivalent

Pentium V, 3.0 GHz, 
Pentium M, 1.5 GHz 
or equivalent

RAM 2 GB 3 GB

free hard drive space 3.5 GB including the memory 
space for the software 
installation, temporary space 
for execution and space for 
saving applications

4 GB

drive DVD reader –

display resolution: 1024 x 786 pixel resolution: 1280 x 1024 pixel

peripherals mouse or compatible 
pointing device
USB interface

–

Internet access no Internet access to register your software by 
web and to retrieve update 
notifications via the Schneider 
Electric Software Update 
(SESU) client
23



System Requirements
Software Requirements

The SoMachine software supports the following operating systems:
Microsoft Windows XP Professional Edition 32 Bits Service Pack 3
Microsoft Windows 7 Professional Edition 32 Bits
Microsoft Windows 7 Professional Edition 64 Bits

SoMachine literature contains PDF-formatted documents that require the 

installation of the Adobe Reader TM. This reader is not part of the SoMachine 
installation but can be downloaded from http://www.adobe.com/go/getreader.
24 04/2012
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What’s in this Chapter?

This chapter contains the following sections:

Section Topic Page

3.1 Basic Installation and Registration of SoMachine 26

3.2 Additional Standalone Installations 30
25



Installation and Registration of SoMachine
3.1 Basic Installation and Registration of SoMachine

Basic Installation and Registration of SoMachine

Overview

The following paragraphs describe how to install SoMachine and how to execute the 
registration. 

General Recommendation

Before you start the SoMachine installation, be sure to first remove (uninstall) any 
existing version of SoMachine and its various parts on your PC. For more 
information refer to Uninstalling SoMachine (see page 29).

 SoMachine Installation Types

The following installation types are available for SoMachine:
Typical: A standard set of SoMachine components will be installed that serves 
typical needs.
Complete: All SoMachine components will be installed.
Compact: A minimum set of SoMachine components will be installed.
Custom: You can select the SoMachine components to create an installation 
adapted to your individual requirements.

The table below lists the SoMachine components that will be installed with the 
different SoMachine installation types:

SoMachine Component Installation Types

Complete Typical Compact Customized

Core components, controllers yes yes yes yes

Vijeo-Designer and HMIs yes yes no optional

Gateway yes yes yes optional

Online help and 
documentation

English yes yes yes yes

user language yes yes no optional

other languages yes no no optional

Legacy support, 
libraries and 
devices

previous version yes yes no optional

all versions 1 no no no optional

Learning Center yes yes no optional

TVD Architectures yes yes no optional

DTMs yes no no optional
26 04/2012



Installation and Registration of SoMachine
1 For further details please see chapter Compatibility and Migration in the Windows 
Start menu Schneider Electric → SoMachine → Documentation.

Installing SoMachine

To install the SoMachine software with its basic functions, insert the SoMachine 
Standard Software DVD in the DVD drive of your PC.

If you have enabled the Autorun function, the SoMachine Media Menu opens 
automatically. To open it manually, double-click the MediaMenu.exe file in the root 
folder of the SoMachine Standard Software DVD.

The Media Menu allows you to select the installation of the desired software 
components. Additionally, you can access information and documentation provided 
on the DVD in a comfortable way prior to the installation.

OPC Server yes no no optional

Schneider Electric Software Update 
(SESU) client

yes yes no optional

SoMachine Component Installation Types

Complete Typical Compact Customized
04/2012 27



Installation and Registration of SoMachine
In the Install Software tab of the Media Menu select the SoMachine Software item 
to install the SoMachine software. The remaining software components in this list 
are part of the SoMachine installation (see the table above for the installation type 
you have to select to install them). But they are also provided here as individual 
installations in order to be able to install them on different computers, independent 
of the SoMachine installation.

The SoMachine setup starts an installation wizard that will guide you through the 
installation process.

In order to use SoMachine functions dedicated to specific solutions, you must 
additionally install the SoMachine Solution Extension after successful installation of 
the SoMachine standard software. To achieve this, insert the SoMachine Solution 
Extension DVD into the DVD drive of your PC. The setup will start automatically if 
you have enabled the Autorun function. Otherwise start the setup manually by 
double-clicking the Setup.exe file.

The setup starts an installation wizard that will guide you through the installation 
process.

For further information on the functions covered by the standard and solution 
SoMachine products refer to the SoMachine Product Offer chapter (see page 37).

Firewall Installed on SoMachine PC

You can install SoMachine on a PC equipped with a firewall that does not block the 
ports that SoMachine uses for communicating with the controllers.

If a firewall is running on the SoMachine PC, it must allow incoming connections on 
the following UDP ports:

1740
1741
1742
1743

Registration

In order to convert your installation from the trial mode into an unlimited, licensed 
installation, restart the setup process and enter the reference number and serial 
number provided on your SoMachine license document. Registration of your 
SoMachine software is highly recommended and even mandatory in some 
countries. You can register your installation via the SoMachine dialog box, tab 
License Agreement, by clicking the button Registration Wizard.

You can open this dialog box in different ways:
from the general functions menu (see SoMachine, Programming Guide) by 
executing the About task
from the Program tab via the Help → About menu
28 04/2012
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You can also start the Registration Wizard directly via Start → Programs → 
Schneider Electric → SoMachine → License Manager.

 SoMachine Update via Schneider Electric Software Update (SESU) Client

With SoMachine 3.0 and later versions the Schneider Electric Software Update 
(SESU) client is automatically installed. It searches for updates of the SoMachine 
software on the web. 

The SESU client is not started automatically. To make it search for available 
SoMachine updates, start it manually by double-clicking the Schneider Electric 
Software Update icon on the desktop of your computer or via Start → Programs → 
Schneider Electric → Schneider Electric Software Update. 

You can also configure regular search intervals via the SESU Settings. For further 
information refer to the Schneider Electric Software Update online help. 

To see which updates of SoMachine are installed on your local computer, go to Start 
→ Control Panel → Add or Remove Programs and select the option Show 
Updates.

Uninstalling SoMachine

Uninstall SoMachine from your computer via Start → Control Panel → Add or 
Remove Programs.
04/2012 29



Installation and Registration of SoMachine
3.2 Additional Standalone Installations

Overview

This section describes the additional standalone installations of software 
components that are provided on the SoMachine DVD related to the offer.

What’s in this Section?

This section contains the following topics:

Topic Page

Installation of the Gateway for SoMachine 31

Installation of the CoDeSys OPC Server 32

Installation of the SESU Client 35
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Installation of the Gateway for SoMachine

General Information

In case you need to provide a single dedicated PC access to the controllers with 
SoMachine and / or the OPC server, you can install the gateway independently of 
the SoMachine software. 

Installation Procedure

To install the gateway, select the item Gateway for SoMachine in the SoMachine 
Media Menu (see page 27). This will install the gateway automatically.

NOTE: In case the current installation of the gateway is not working or has been 
corrupted by other software, for example third party software, execute this 
procedure again to reinstall the gateway.
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Installation of the CoDeSys OPC Server

Overview

You can install the CoDeSys OPC server in 2 different ways on different platforms:
in the course of the SoMachine installation on the SoMachine PC
by starting an individual CoDeSys OPC server installation for installation on a 
separate PC that is not running SoMachine

Installation on the SoMachine PC

The OPC server installation is part of the SoMachine installation.

You can install it with the following SoMachine installation types (see page 26) on 
the SoMachine PC:

Complete: automatically installs the OPC server
Custom: Select the item OPC Server in the list of program features to be 
installed.

To install the OPC server on a different PC, that is not running SoMachine, in order 
to fulfill the requirements of high-availability, proceed as described in the next 
section.
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Separate Installation on a Different PC

To be able to install the OPC server independent of the SoMachine installation on 
another PC, a separate OPC server installation is provided in the SoMachine Media 
Menu.

Select the entry OPC Server from the SoMachine Media Menu and follow the 
instructions given on screen to install the OPC server.

The installation of the OPC server automatically installs the stand-alone SoMachine 
gateway. It provides access to remote controllers via the OPC server. You can 
manually remove the gateway later if you want to use a remote gateway instead.

Troubleshooting

The installation introduces the OPC server as a COM server on the PC that can be 
started from any local or remote client. In practice, the start of a remotely running 
OPC server, the browsing of its address space and the transfer of data is often 
affected by incorrect or incomplete DCOM permission settings on the server and / 
or client machine. For further information refer to the relevant literature provided by 
Microsoft.
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Accessing the CoDeSys OPC Server

After successful installation of the OPC server, it can be accessed by an OPC client. 

To connect to the OPC server, use the browse function of your OPC client or 
explicitly enter the server name CoDeSys.OPC.DA.

As soon as a client establishes a connection, the OPC server is started 
automatically by the operating system. It can interact with multiple clients in parallel. 
As soon as the last client disconnects, the OPC server is automatically shut down.

Installation and Registration

Execute the command WinCoDeSysOPC/RegServer to register the server as 
COM server. The current position of the WinCoDeSysOPC.exe file will be used as 
location path. Thus the call only may be done from a local path. 

Registration as Service

Execute the command WinCoDeSysOPC/Service to install 
WinCoDeSysOPC.exe as system service. Started once, the service will run until the 
system is shut down. The communication to the configured controllers survives. The 
service is also installed in the directory where the WinCoDeSysOPC.exe file is 
saved.

Uninstalling the CoDeSys OPC Server

Execute the command WinCoDeSysOPC/UnRegServer to remove the entries of 
the OPC server from the registry. The installed files will not be removed.
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Installation of the SESU Client

General Information

In case you want to use a separate PC to check the Schneider Electric servers for 
software updates for SoMachine and / or other Schneider Electric software, you can 
install the Schneider Electric Software Update (SESU) client as standalone product. 

Once installed and started, the SESU client will notify you about available updates 
and other relevant information. You can download the files provided by Schneider 
Electric to your PC using the SESU client. You can then transfer the updates and 
files to other PCs.This feature my be useful for centralized management of updates 
by the IT department in bigger organizations.

Installation Procedure

To install the SESU client, select the item SESU Software from the SoMachine 
Media Menu (see page 27) and follow the instructions given on screen.
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SoMachine Product Offer
SoMachine Product Offer Contents

Overview

The following SoMachine product offers are available:
SoMachine Standard Software with basic functions
SoMachine Solution Extension with additional SoMachine functions dedicated to 
specific solutions

Differences Between the Standard Software and the Solution Extension

The following table lists the differences between the 2 product offers:

SoMachine Version 3.1 SoMachine Version 3.1 Solution 
Extension

The Solution Extension is installed 
additionally on the PC where 
SoMachine is already installed.

M238 Controllers Generic devices
M238 

TM238LDA24DR
TM238LDD24DT
TM238LFAC24DR
TM238LFDC24DT

Adds the S-type devices:
M238 

TM238LFAC24DRS0
TM238LFDC24DTS0

M258 Controllers Generic devices
M258

TM258LD42DT
TM258LD42DT4L
TM258LF42DR
TM258LF42DT
TM258LF42DT4L
TM258LF66DT4L

Adds the S-type devices:
M258

TM258LF42DRS0
TM258LF42DT4LS0
TM258LF42DTS0
TM258LF66DT4LS0
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SoMachine Product Offer
HMI Small Terminal Generic devices
HMISTU655, HMISTU855 
HMISTO511, HMISTO512, 
HMISTO531, HMISTO532

–

XBTGC Controllers Generic devices
XBTGC

XBTGC1100
XBTGC2120
XBTGC2230

CANopen Master Module for 
XBTGC

XBTZGCCAN

Adds the S-type devices:
CANopen Master Module S-Type 
for XBTGC

XBTZGCCANS0

XBTGT/GK Controllers Generic devices
XBTGT/GK with control

XBTGK2120 with Control
XBTGK2330 with Control
XBTGK5330 with Control
XBTGT2110 with Control
XBTGT2120 with Control
XBTGT2130 with Control
XBTGT2220 with Control
XBTGT2330 with Control
XBTGT2430 with Control
XBTGT2930 with Control
XBTGT4230 with Control
XBTGT4330 with Control
XBTGT5230 with Control
XBTGT5330 with Control
XBTGT5340 with Control
XBTGT5430 with Control
XBTGT6330 with Control
XBTGT6340 with Control
XBTGT7340 with Control

CANopen Master Module for 
XBTGT/GK

XBTZGCANM

Adds the S-type devices:
CANopen Master Module S-Type 
for XBTGT/GK

XBTZGCANMS0

LMC058 Controllers Generic devices
LMC058

LMC058LF424
LMC058LF42

Adds the following LMC058 S-Type 
controllers:

LMC058
LMC058LF424S0
LMC058LF42S0

SoMachine Version 3.1 SoMachine Version 3.1 Solution 
Extension
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ATV IMC Controllers Generic devices:
ATV IMC

VW3A3521

Adds the following ATV IMC S-Type 
controller:

ATV IMC
VW3A3521S0

Application Libraries Energy Efficiency Toolbox Library
Modbus Energy Efficiency Toolbox 
Library
Machine Energy Dashboard Library

Adds the application libraries:
Packaging Library
Conveying Library
Hoisting Library

Communication Libraries PLC Communication Library
Modem Library

–

Generic Libraries Toolbox Library
DataLogging Library
SE_NetVarUdp Library
SysTime Library
Toolbox_Advanced Library

–

Devices Libraries TeSys Library
Altivar Library
Integrated Lexium Library
Lexium Library
CANmotion Lexium Library
M238 PLCSystem Library
M238 HSC Library
M238 PTOPWM Library
XBT PLCSystem Library
XBTGC HSC Library
XBTGC PTOPWM Library
ATV IMC PLCSystem Library
ATV IMC HSC Library
ATV IMC UserLib Library
M258 PLCSystem Library
M258 HSC Expert I/O Library
M258 PWM Expert I/O Library
LMC058 PLC System Library
LMC058 HSC Expert I/O Library
LMC058 PWM Expert I/O Library
TM5 Expert Modules PTOLib 
Library
TM5 Expansion Modules 
StrainedGaugeLib Library

–

SoMachine Version 3.1 SoMachine Version 3.1 Solution 
Extension
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The following table lists the different System User Guides and Project Templates of 
Tested, Validated and Documented Architecture (TVDA) between the 2 product 
offers:

SoMachine Version 3.1 SoMachine Version 3.1 Solution Extension

The following generic TVDAs are provided: Adds the following application TVDAs:

TVDA TVDA U.S. TVDA TVDA U.S.

Optimized HW XBTGC Optimized HW XBTGC 
(U.S.)

Hoisting Optimized 
CANopen ATV IMC (project 
template only)

Hoisting Optimized 
CANopen ATV IMC (U.S.) 
(project template only)

Optimized CANopen 
XBTGC

Optimized CANopen 
XBTGC (U.S.)

Packaging Optimized 
CANopen M238 (project 
template only)

Packaging Optimized 
CANopen M238 (U.S.) 
(project template only)

Optimized HW M238 Optimized HW M238 (U.S.) Packaging Performance 
CANopen M258 (project 
template only)

Packaging Performance 
CANopen M258 (U.S.) 
(project template only)

Optimized CANopen M238 Optimized CANopen M238 
(U.S.)

Packaging Performance 
CANmotion LMC058 
(project template only)

Packaging Performance 
CANmotion LMC058 (U.S.) 
(project template only)

Performance HW M258 Performance HW M258 
(U.S.)

Conveying Performance 
CANopen LMC058

Conveying Performance 
CANopen LMC058 (U.S.)

Performance CANopen 
M258

Performance CANopen 
M258 (U.S.)

Hoisting Optimized 
CANopen M238 

Hoisting Optimized 
CANopen M238 (U.S.)

Performance CANmotion 
LMC058

Performance CANmotion 
LMC058 (U.S.)

– –

Optimized CANopen 
ATV IMC

Optimized CANopen 
ATV IMC (U.S.)

– –
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Compatibility and Migration
Overview

This part provides information to help you to deal with the updates of the different 
elements of your system as SoMachine application, SoMachine project, device 
firmware, Vijeo-Designer application, device description and others.

What’s in this Part?

This part contains the following chapters:

Chapter Chapter Name Page

5 General Information 43

6 Compatibility Use Cases 47

7 Migration Considerations 57
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General Information
General Information

Overview

SoMachine and the devices supported by SoMachine are continuously improved. 
Therefore, new updates of SoMachine and its associated devices are released on a 
regular basis.

SoMachine Software provides in most cases a simple and straight forward way to 
migrate projects created with previous versions of SoMachine to the current version.

NOTE: 

Schneider Electric recommends to regularly launch the Schneider Electric 
Software Update (SESU) software (see page 29) to obtain the latest SoMachine 
updates.
Schneider Electric recommends that you visit the Schneider Electric website 
www.schneider-electric.com to download the latest device firmwares available.

In specific scenarios, it is possible that you encounter compatibility issues regarding 
these updates, and actions are required to establish consistency with your existing 
systems and project files for the following elements:

SoMachine files created with a previous SoMachine version (projects, archives, 
exports)
device firmware versions (controllers, HMI terminals)
related software (Vijeo-Designer)
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SoMachine Software

When installing a new version of SoMachine (see page 26), components of 
SoMachine are updated with the latest version available, which includes:

Component Description

Compiler version The compiler is the software that converts your project into the binary 
code that is downloaded and executed on the controller.
It is executed when you execute a Build, Build All, Rebuild or 
Generate Code action in SoMachine. The version of the compiler used 
is independent to your SoMachine version and can be defined by 
selecting: Project → Project Settings → Compile options
By default, the latest compiler version is selected and we highly 
recommend that you keep this default.

Device description 
version

The device description defines the properties of a device such as 
configurability, programmability and possible connections to other 
devices.
When you insert a device inside a project, SoMachine uses the device 
description to define the properties of the device.
The device description version is displayed in the Information tab of 
the device of your project:

Library version A library is a container of variable lists, data structures (DUTs), 
functions and function blocks (POU) that can be used in your 
projects.The versions of libraries used in an application are visible in 
the Library Manager:
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General Information
There are 2 types of project files which are created by SoMachine:

The following elements can have compatibility issues between SoMachine versions:
Project files (see page 49)
Archives files (see page 49)
Device firmwares (see page 53)
Vijeo-Designer software (see page 120)

Device Firmware

The firmware is the software embedded in the controller.

The firmware version is displayed in the Services tab that you can find by double-
clicking on your controller in the Commissioning tab window:

File Type Description

*.project The version of a SoMachine project file is determined by the 
application file version and the application profile.
application file version: The version of the application file is defined 

by the version of SoMachine that saved this application file. It acts 
as a container that specifies the storage format for the content of 
the application.

application profile: The application profile contains the versions of 
device descriptions and the versions of the libraries used, the 
compiler version and the visualization profile. The application 
profile applies to all the applications of the project.

When a SoMachine project has a Vijeo-Designer application, it is 
saved in the *.project file.

*.projectarchive A project archive can be created by using SoMachine and be saved on 
your PC as a *.projectarchive file. This file contains one project and can 
contain download information files, referenced devices and referenced 
libraries.
You can also do a Source download to create an archive as an 
Archive.prj file in your controller.
04/2012 45



General Information
Vijeo-Designer Software

The Vijeo-Designer software is a Windows application that allows you to create your 
HMI applications.

The SoMachine installation includes the installation of Vijeo-Designer but this 
software is independent to SoMachine and can be installed or updated without the 
SoMachine software.

For compatibility information with Vijeo-Designer, refer to Compatibility of 
SoMachine and Vijeo-Designer versions (see page 120)
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Compatibility Use Cases
Overview

This chapter provides information on compatibility situations you can encounter 
when you install a new version of the SoMachine software, acquire a new device or 
a new version of Vijeo-Designer software.

What’s in this Chapter?

This chapter contains the following sections:

Section Topic Page

6.1 Using a New Version of SoMachine Software 48

6.2 Using a New Version of Vijeo-Designer Software 54

6.3 Using a New Controller 55
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Compatibility Use Cases
6.1 Using a New Version of SoMachine Software

Overview

This section describes the compatibility use cases you can encounter when 
installing a new version of SoMachine.

Refer to Installation and Registration of SoMachine for information about installation 
procedure (see page 26).

What’s in this Section?

This section contains the following topics:

Topic Page

Using Existing SoMachine Projects 49

Creating a Project in a New SoMachine Version 52

Using a Device with an Earlier Firmware Version 53
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Using Existing SoMachine Projects

Overview

You can use existing projects created with a previous SoMachine version by 
different ways:

Open a *.project file
Extract Archive a *.projectarchive file
Source Upload a *.prj file from a controller

When you open a project that was created with an earlier SoMachine version than 
the version you are using, the following message is displayed:

Using your SoMachine Projects With Update

If you wish to take advantage of the latest features and functions of the new version 
of SoMachine, you will want to update your projects.

Click Yes to update your project to the new version of SoMachine.

The following elements are updated:
the project file version when saving the project,
the application profile (device descriptions and libraries), and
the visualization profile.

A build and a download of the project to the controller is necessary after the update.

NOTE: 

After the update of the project,
you can encounter device firmware compatibility issues (see page 53),
you cannot open the project in an earlier SoMachine version.

NOTICE
LOSS OF DATA

Always make a backup of your project file before you use it with a new SoMachine 
version.

Failure to follow these instructions can result in equipment damage.
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Using your SoMachine Projects Without Update

Click No if you have a new version of SoMachine but you do not want to make any 
changes to your project.

NOTE: If you do not update your project, the latest functionalities of SoMachine are 
not available.

If you selected the Support of earlier versions option during installation procedure, 
it is possible to build and download the old application into the controller.

NOTE: The option Support of earlier versions is automatically selected in typical 
and complete installation (see page 26).

You can login to your controller without building and downloading the project only if 
a Download Information Files file (*.compileinfo) was created in the same 
directory as the project on your PC.

In any case, if your project was modified, or if the compiler version in your project 
was manually selected a rebuild of the project is necessary.

Refer to the migration recommendations (see page 57) for more information on how 
to reduce the effect of a new version of SoMachine on your projects.

NOTE: If your projects include or are based on HMI, the HMI runtime is updated 
during the download of the project (see page 119).

Projects Using HMI Controllers

The Vijeo-Designer software has its own rules which are defined in the Vijeo-
Designer Documentation: 3.0 Before you begin → 3.2 Compatibility

Vijeo-Designer can open an application created by an earlier version and 
automatically convert this application into the new version.

NOTE: The converted application can no longer be opened with an earlier version 
of Vijeo-Designer.

By downloading the HMI application part with SoMachine V3.1 (or with Vijeo-
Designer), the HMI Runtime on the device is updated.

NOTE: Access to this HMI controller with an earlier SoMachine version is no longer 
possible.
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Projects with External Elements

If you did not follow the migration recommendations (see page 57) when using your 
previous SoMachine versions, you can encounter the following issues with external 
elements:

a project that contains a device description installed from an EDS file, the device 
can not be recognized by the new SoMachine version. You must install the device 
in the Device Repository,
a project that contains a library that is not part of the SoMachine installation, the 
library can not be recognized by the new SoMachine version. You must add the 
library in the Library Manager.
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Creating a Project in a New SoMachine Version

Overview

When you create a project in SoMachine,
you can encounter a device firmware compatibility (see page 53) issues.
you cannot open the project in an earlier SoMachine version.
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Compatibility Use Cases
Using a Device with an Earlier Firmware Version

Overview

When login or downloading a new or an updated project with a new version of 
SoMachine, you can encounter a compatibility problem with your current controller 
firmware:

In this popup, the requested version is the device description version of the active 
application; the online version is the firmware version of the controller.

In this case, updating the device firmware is necessary. Device firmwares are 
provided inside SoMachine installation or can be found on the Schneider Electric 
website: www.schneider-electric.com.

Refer to the migration recommendations (see page 57) to understand how to avoid 
this situation in future versions of SoMachine.
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Compatibility Use Cases
6.2 Using a New Version of Vijeo-Designer Software

Using a New Version of Vijeo-Designer Software

Overview

SoMachine is shipped with a specific version of Vijeo-Designer. You should not use 
a different version of Vijeo-Designer software. 

For more information refer to the chapter Compatibility of SoMachine and Vijeo-
Designer Versions in the Appendix (see page 120).
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6.3 Using a New Controller

Using a New Controller

Overview

We update the controller frequently providing new features and functions. Therefore 
there may be a difference between the version you receive as a new product, the 
current version being put into stock from the factory, and the version of your 
SoMachine installation.

Basically, you can encounter 2 situations:
You received a controller with a firmware version older than the one of the 

device description in your SoMachine project: In this case, updating the 
controller firmware is necessary. Controller firmwares are provided inside the 
SoMachine installation or can be found on the Schneider Electric website: 
www.schneider-electric.com.
If you do not update your controller, you will be able to login to your controller only 
if the compatibility rule is respected (see page 118).

You received a controller with a firmware version newer than the one of the 
device description in your SoMachine project:  No update is required. You 
can directly download the application into the new controller.
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Migration Considerations
Creating an Archive

Overview

Before you install a new version of SoMachine software or when your project is 
finalized, you should create an archive of your project.

Creating an archive can help reduce compatibility issues with later versions of 
SoMachine.

Create an Archive on your Local Computer

When you create an archive, you can save additional information that would not 
normally be kept in a *.project file:

Download Information file
third party libraries
EDS files

When you extract your archive in SoMachine, all the files contained in your archive 
are automatically installed in your current SoMachine version.

To create an archive on your local computer select File → Project Archive → 
Save/Send Archive...

The following window is displayed:
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Migration Considerations
The following topics can affect compatibility and therefore you must select them:

NOTE: For more information, refer to the CoDeSys part of the SoMachine online 
help.

Create an Archive on your Controller

You can archive your project on your controller by using the command: Online → 
Source download to connected device

To define what you want to add to the archive, select Project → Project Settings 
→ Source Download → Additional Files

The following window is displayed:

See the previous table for more information.

Information Description

Download Information 
Files

When this is selected, all the compile information (the *.compileinfo file) is saved with 
your project file.
This allows you to login to the controllers with the archived project without rebuilding the 
project.

Referenced devices When this is selected, all the devices in the Device Repository of your project are saved 
into the archive with their current versions.
Devices installed with EDS files are included.

Referenced libraries When this is selected, all the libraries in the Library Repository of your project are 
saved into the archive with their current versions.
Third party libraries are included.
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Introduction

This part provides information about the devices that SoMachine can configure and 
program.

What’s in this Part?

This part contains the following chapters:

Chapter Chapter Name Page

8 Optimized Controllers 61

9 Performance Controllers 79

10 HMI Terminals 101

11 Distributed Devices 109
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Optimized Controllers
What’s in this Chapter?

This chapter contains the following sections:

Section Topic Page

8.1 M238 Logic Controllers 62

8.2 TM2 Expansion Modules 67

8.3 XBTGC, XBTGT, XBTGK HMI Controllers 73

8.4 ATV IMC Drive Controllers 77
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Optimized Controllers
8.1 M238 Logic Controllers

What’s in this Section?

This section contains the following topics:

Topic Page

Modicon M238 Logic Controller Devices Overview 63

AS-Interface Master Module for the M238 Controller 65

Ethernet Gateway for Modicon M238 Logic Controller 66
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Modicon M238 Logic Controller Devices Overview

Overview

The Schneider Electric Modicon M238 Logic Controller has a variety of powerful 
features. This controller can service a wide range of applications.

Key Features

The Modicon M238 Logic Controller is supported and programmed with the 
SoMachine Programming Software, which provides the following IEC61131-3 
programming languages:

IL: Instruction List
ST: Structured Text
FBD: Function Block Diagram
SFC: Sequential Function Chart
LD: Ladder Diagram
CFC: Continuous Function Chart 

The Modicon M238 Logic Controller can manage up to 7 tasks (1 MAST task and up 
to 6 other tasks).

The power supply of Modicon M238 Logic Controller is either:
24 Vdc
100...240 Vac

The Modicon M238 Logic Controller with DC power supply includes the following 
features:

14 digital inputs, including 8 fast inputs
10 digital outputs, including 4 fast outputs

The Modicon M238 Logic Controller with AC power supply includes the following 
features:

14 digital inputs, including 8 fast inputs
10 digital outputs, including 6 relay outputs
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Modicon M238 Logic Controller Range

The following table describes the M238 range (see M238 Logic Controller, 
Hardware Guide) and features:

(1) The fast inputs can be used either as regular inputs or as fast inputs for counting 
or event functions.

(2) The fast outputs can be used either as regular outputs or as fast outputs for PTO 
(Pulse Train Output), HSC (High Speed Counter), PWM (Pulse Width Modulation), 
or FG (Frequency Generator) functions.

Reference Power Supply Serial Ports CANopen 
Master

Digital 
Inputs

Digital 
Outputs

Memory 
size

M238 DC Range

TM238LFDC24DT••
24 Vdc

SL1: 
RS232/RS485
SL2: RS485

Yes 8 fast 

inputs(1)

+
6 regular 
inputs

4 transistor 
fast 

outputs(2)

+
6 transistor 
regular 
outputs

2 MB

TM238LDD24DT

24 Vdc

SL1: 
RS232/RS485 No

1 MB

M238 AC Range

TM238LFAC24DR••
100...240 Vac

SL1: 
RS232/RS485
SL2: RS485

Yes
8 fast 

inputs(1)

+
6 regular 
inputs

4 transistor 
outputs
+
6 relay 
outputs

2 MB

TM238LDA24DR
100...240 Vac

SL1: 
RS232/RS485

No
1 MB
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AS-Interface Master Module for the M238 Controller

Introduction

The following paragraph lists the AS-Interface Master Module for M238 supported 
by SoMachine with its description.

AS-Interface Master Module for the M238 Controller

The following AS-Interface Master Module is available for the M238 controller:

The AS-Interface Master Module is described in the Modicon TWDNOI10M3 AS-
Interface Master Module Hardware Guide (see Modicon TWDNOI10M3, AS-
Interface Master Module, Hardware Guide).

Each M238 controller supports a maximum of 2 AS-Interface Master Modules. 

Reference Description

TWDNOI10M3 The AS-Interface Master Module manages all exchange of 
data on the AS-Interface network.
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Ethernet Gateway for Modicon M238 Logic Controller

Introduction

The following paragraph lists the Ethernet Gateway supported by SoMachine with 
their descriptions. 

NOTE: For further information refer to Connection and Configuration of the Ethernet 
Gateway (see Modicon M238 Logic Controller, Programming Guide).

Ethernet Gateway for Modicon M238 Logic Controller

The following Ethernet Gateway module is available for Modicon M238 Logic 
Controller.

The Ethernet Gateway module is described in the 499TWD01100 Ethernet/Modbus 
Gateway for M238 Hardware Guide

Reference Description

499TWD01100 Ethernet/Modbus gateway to be used with the Modicon M238 
Logic Controller. The gateway is used to connect a single 
controller Modbus/RTU (RS485) device and the physical layer 
of Modbus/TCP networks.The gateway module supports slave 
mode only.
66 04/2012



Optimized Controllers
8.2 TM2 Expansion Modules

What’s in this Section?

This section contains the following topics:

Topic Page

TM2 Digital Input and Output Expansion Modules 68

TM2 Analog Input and Output Expansion Modules 70

TM2 High-Speed Counting I/O Expansion Modules 72
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TM2 Digital Input and Output Expansion Modules

Introduction

The following paragraph lists the TM2 digital I/O modules for Modicon M238 Logic 
Controller and XBTGC HMI Controller that are supported by SoMachine with their 
complete name and catalog reference. 

NOTE: To add a digital module, refer to Adding Expansion Modules (see Modicon 
M238 Logic Controller, Programming Guide).

Supported Modules

The Modicon M238 Logic Controller and the XBTGC HMI Controller support the 
following I/O modules:

Module 
Reference

Channels Channel Type Voltage/Current Terminal Block

Input Modules

TM2DAI8DT 8 inputs 120 Vac
7.5 mA

removable with screw

TM2DDI8DT 8 inputs 24 Vdc
7 mA

removable with screw

TM2DDI16DT 16 inputs 24 Vdc
7 mA

removable with screw

TM2DDI16DK 16 inputs 24 Vdc
5 mA

HE10 connector

TM2DDI32DK 32 inputs 24 Vdc
5 mA

HE10 connector

Output Modules

TM2DRA8RT 8 outputs
relay

30 Vdc/230 Vac
2 A max

removable with screw

TM2DRA16RT 16 outputs
relay

30 Vdc/230 Vac
2 A max

removable with screw

TM2DD08UT 8 outputs
transistor sink

24 Vdc
0.3 A max per 
output

removable with screw

TM2DD08TT 8 outputs
transistor 
source

24 Vdc
0.5 A max per 
output

removable with screw

TM2DDO16UK 16 outputs
transistor sink

24 Vdc
0.1 A max per 
output

HE10 connector
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TM2DDO16TK 16 outputs
transistor 
source

24 Vdc
0.4 A max per 
output

HE10 connector

TM2DDO32UK 32 outputs
transistor sink

24 Vdc
0.1 A max per 
output

HE10 connector

TM2DDO32TK 32 outputs
transistor 
source

24 Vdc
0.4 A max per 
output

HE10 connector

Mixed Modules

TM2DMM8DRT 4
4

inputs
outputs
relay

24 Vdc/7 mA
30 Vdc/230Vac
2 A max

removable with screw

TM2DMM24DRF 16
8

inputs
outputs
relay

24 Vdc/7 mA
30 Vdc/230Vac
2 A max

non-removable 
spring

Module 
Reference

Channels Channel Type Voltage/Current Terminal Block
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TM2 Analog Input and Output Expansion Modules

Introduction

The following paragraph lists the analog I/O modules for Modicon M238 Logic 
Controller and XBTGC HMI Controller that are supported by SoMachine with their 
complete name and catalog reference. 

NOTE: To add an analog module, refer to Adding Expansion Modules chapter in the 
SoMachine Programming Guide (see Modicon M238 Logic Controller, 
Programming Guide).

Supported Modules

The Modicon M238 Logic Controller and the XBTGC HMI Controller support the 
following I/O modules:

Module 
Reference

Channels Channel Type Voltage/Current Terminal Block

Input Modules

TM2AMI2HT 2 high-level inputs 0...10 Vdc
4...20 mA

removable with 
screw

TM2AMI2LT 2 low-level inputs Thermocouple type 
J,K,T

removable with 
screw

TM2AMI4LT 4 inputs 0...10 Vdc
0...20 mA
PT100/1000
Ni100/1000

removable with 
screw

TM2AMI8HT 8 inputs 0...20 mA
0...10 Vdc

removable with 
screw

TM2ARI8HT 8 inputs NTC / PTC removable with 
screw

TM2ARI8LRJ 8 inputs PT100/1000 RJ11 connector

TM2ARI8LT 8 inputs PT100/1000 removable with 
screw

Output Modules

TM2AMO1HT 1 output 0...10 Vdc
4...20 mA

removable with 
screw

TM2AVO2HT 2 outputs +/- 10 Vdc removable with 
screw
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Mixed Modules

TM2AMM3HT 2
 
1

inputs
 
output

0...10 Vdc 
4...20 mA
0...10 Vdc 
4...20 mA

removable with 
screw

TM2AMM6HT 4
 
2

inputs
 
outputs

0...10 Vdc 
4...20 mA
0...10 Vdc 
4...20 mA

removable with 
screw

TM2ALM3LT 2
 
1

low-level inputs
 
output

Thermo J,K,T, 
PT100
0...10 Vdc 
4...20 mA

removable with 
screw

Module 
Reference

Channels Channel Type Voltage/Current Terminal Block
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TM2 High-Speed Counting I/O Expansion Modules

Introduction

The following paragraph lists the HSC expansion modules for Modicon M238 Logic 
Controller that are supported by SoMachine with their description. 

NOTE: To add an expansion module, refer to Adding Expansion Modules 
(see Modicon M238 Logic Controller, Programming Guide).

Supported Modules

The HSC modules are only available with the Modicon M238 Logic Controller.

Each Modicon M238 Logic Controller supports a maximum of 3 HSC expansion 
modules.

Reference Description

TM200HSC206DT 2 High Speed Counters, Frequency 60 kHz, Expansion Module, 
Removable screw terminal block (supplied)

TM200HSC206DF 2 High Speed Counters, Frequency 60 kHz, Expansion Module, 
Removable spring terminal block (supplied)
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8.3 XBTGC, XBTGT, XBTGK HMI Controllers

What’s in this Section?

This section contains the following topics:

Topic Page

XBTGC HMI Controller 74

XBTGT/GK HMI Controllers 75

CANopen Master Modules for XBTGC, XBTGT and XBTGK HMI Controllers 76
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XBTGC HMI Controller

Introduction

Software configuration and hardware description can be found in the following 
manuals:

XBTGC HMI Controller Hardware Guide (see Magelis XBTGC HMI Controller, 
Hardware Guide)
XBTGC HMI Controller Programming Guide (see Magelis XBTGC HMI 
Controller, Programming Guide)

Key Features

The XBTGC HMI Controllers support the following IEC61131-3 programming 
languages:

IL: Instruction List
ST: Structured Text
FBD: Function Block Diagram
SFC: Sequential Function Chart
LD: Ladder Diagram
CFC: Continuous Function Chart 

The XBTGC HMI Controllers can manage up to 3 tasks:
1 unique and mandatory MAST task can be configured in ‘Freewheeling 
(see Magelis XBTGC HMI Controller, Programming Guide)’ or ‘Cyclic 
(see Magelis XBTGC HMI Controller, Programming Guide)’ mode.
2 other tasks can be configured in ‘Freewheeling’ (only if the MAST task is not 
configured in Freewheeling), ‘Cyclic’ or ‘Event (see Magelis XBTGC HMI 
Controller, Programming Guide)’ mode.

XBTGC HMI Controller Range

The following table describes the XBTGC HMI Controller

XBTGC 1100 XBTGC 2120 XBTGC 2230

Embedded inputs 12 16 16

Embedded outputs 6 16 16

Display type Monochrome 
Amber/Red LCD

Monochrome LCD STN Color LCD

Expansion modules 2 max. 3 max. 3 max.

Ethernet interface Not available Not available Available

Serial interface (COM1) Not available RS232/RS422/RS485 serial 
interface. SUB-D 9-pin plug 
connector.

RS232/RS422/RS485 serial 
interface. SUB-D 9-pin plug 
connector.

USB Interface Available Available Available
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XBTGT/GK HMI Controllers

Introduction

XBTGT/GK HMI terminals (see page 101) become controllers when a CANopen 
module (see page 76) is attached to them. 

Software configuration and hardware description can be found in the following 
manuals:

Magelis XBTGT, XBTGK, XBTGH Hardware Guide
Magelis XBTGT, XBTGK HMI Controller Programming Guide

XBTGT/GK Key Features

The XBTGT/GK HMI controllers support the following IEC61131-3 programming 
languages:

IL: Instruction List
ST: Structured Text
FBD: Function Block Diagram
SFC: Sequential Function Chart
LD: Ladder Diagram
CFC: Continuous Function Chart 

The XBTGT/GK HMI controllers can manage up to 3 tasks:
1 unique and mandatory MAST task can be configured in ‘Freewheeling 
(see Magelis XBT GT, HMI Controller, Programming Guide)’ or ‘Cyclic 
(see Magelis XBT GT, HMI Controller, Programming Guide)’ mode.
2 other tasks can be configured in ‘Freewheeling’ (only if the MAST task is not 
configured in Freewheeling), ‘Cyclic’ or ‘Event (see Magelis XBT GT, HMI 
Controller, Programming Guide)’ mode.

XBTGT/GK Terminal Range

For key features as well as a list of the range of XBTGT/GK HMI terminals refer to 
the HMI Terminals chapter of this document (see page 101).
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CANopen Master Modules for XBTGC, XBTGT and XBTGK HMI Controllers

Introduction

The following paragraph lists the CANopen Master / CANopen Master S-type 
modules supported by SoMachine with their description.

CANopen Master Module for the XBTGC HMI Controller

The following CANopen Master modules (XBTZGCCAN and XBTZGCCANS0) are 
available for the XBTGC HMI Controller:

NOTE: For more information refer to the Magelis XBTGC HMI Controller 
Programming Guide.

CANopen Master Module for the XBTGT/GK HMI Controller

The following CANopen Master modules (XBTZGCANM and XBTZGCANMS0) are 
available for the XBTGT/GK HMI Controller:

NOTE: For more information refer to the Magelis XBTGT, XBTGK HMI Controller 
Programming Guide.

Reference Description

XBTZGCCAN
XBTZGCCANS0 (to be 
used if S-type controller is 
requested)

CANopen Master Module conforms to EN61000-6-2 Standard, 
5 Vdc, 2.4 W max, communication module, extension 
connector, multi-drop connection, half duplex serial 
transmission.

Reference Description

XBTZGCANM
XBTZGCANMS0 (to be 
used if S-type controller is 
requested)

CANopen Master Module conforms to EN61000-6-2 Standard, 
5 Vdc, 2.4 W max, communication module, extension 
connector, multi-drop connection, half duplex serial 
transmission.
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8.4 ATV IMC Drive Controllers

ATV IMC Drive Controller

Introduction

The ATV IMC Drive Controller (ATV IMC: Altivar Integrated Machine Controller) is 
an option card which can be installed in the Altivar 61 or the Altivar 71 drive. It can 
be combined with another option card (I/O extension or communication).

NOTE: The ATV IMC is compatible with drives containing a firmware version greater 
than or equal to V3.3ie43.

Only one ATV IMC Drive Controller option card can be installed on a drive.

The ATV IMC Drive Controller is used to adapt the variable speed drive to specific 
applications by integrating control system functions.

Key Features

The ATV IMC Drive Controller supports the following IEC61131-3 programming 
languages using the SoMachine software:

IL: Instruction List
ST: Structured Text
FBD: Function Block Diagram
SFC: Sequential Function Chart
LD: Ladder Diagram
CFC: Continuous Function Chart 

The ATV IMC Drive Controller can manage up to 9 tasks.

The ATV IMC Drive Controller includes the following features using the SoMachine 
software:

10 digital inputs (2 inputs can be used for 2 counters or 2 inputs can be used for 
2 incremental encoders)
2 analog inputs
6 digital outputs
2 analog outputs
A master port for the CANopen bus
A mini-USB B port for programming with SoMachine software
An Ethernet port to be used for programming with SoMachine software or 
Modbus TCP communication.
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The ATV IMC Drive Controller can also use:
The drive I/O
The I/O extension card (I/O basic and I/O extended)
The encoder interface card points counter
The drive parameters (speed, current, torque, etc.)
The drive remote keypad (as application HMI).

Compatible Option Cards

The following table provides the references of the ATV 61/71 option cards 
compatible with the ATV IMC Drive Controller:

Features of the ATV IMC Drive Controller

The following table lists the features of the ATV IMC drive controller:

Reference Option Card Description

VW3A3201 Logic I/O card

VW3A3202 Extended I/O card

VW3A3303 Modbus ASCII communication card

VW3A3310D Modbus TCP/IP Daisy-Chain Ethernet card

VW3A3304 Interbus communication card

VW3A3316 Ethernet IP communication card

VW3A3309 DeviceNet communication card

VW3A3307 Profibus DP communication card

VW3A3307S371 Profibus DP V1 communication card

Reference Power 
Supply

Ethernet 
Interface

CANopen 
Master

Digital 
Inputs

Digital 
Outputs

Analog 
Inputs

Analog 
Outputs

Memory 
Size

VW3A3521•• 24 Vdc yes yes 10 6 2 2 3 MB
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9.1 M258 Logic Controllers

Modicon M258 Logic Controller

Overview

Software configuration and hardware description can be found in the following 
manuals:

Modicon M258 Logic Controller programming guide (see Modicon M258 Logic 
Controller, Programming Guide)
Modicon M258 Logic Controller hardware guide (see Modicon M258, Logic 
Controller, Hardware Guide)

The Schneider Electric Modicon M258 Logic Controller is a controller with a variety 
of powerful features. It can control a wide range of applications.

The Software configuration is described in the SoMachine Programming Guide 
(see Modicon M258 Logic Controller, Programming Guide).

Key Features

The SoMachine software compatible with Modicon M258 Logic Controller provides 
the following IEC61131-3 programming languages:

IL: Instruction List
ST: Structured Text
FBD: Function Block Diagram
SFC: Sequential Function Chart
LD: Ladder Diagram
CFC: Continuous Function Chart 

All controllers include:
CANopen Master
Ethernet
Serial Line
Expert functions (counting, reflex outputs...)
Embedded I/Os

All controllers support up to 20 tasks with the following limits:
4 cyclic tasks: one is configured by default (Mast)
1 freewheeling task
8 software event driven tasks
8 hardware event driven tasks
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Controller Range

PCI CAN USB A USB Pgr Eth SL

TM258LD42DT (see Modicon 
M258, Logic Controller, 
Hardware Guide)

0 0 1 1 1 1

TM258LD42DT4L 
(see Modicon M258, Logic 
Controller, Hardware Guide)

2 0 1 1 1 1

TM258LF42DT•• (see Modicon 
M258, Logic Controller, 
Hardware Guide)

0 1 1 1 1 1

TM258LF42DT4L•• 
(see Modicon M258, Logic 
Controller, Hardware Guide)

2 1 1 1 1 1

TM258LF66DT4L•• 
(see Modicon M258, Logic 
Controller, Hardware Guide)

2 1 1 1 1 1

TM258LF42DR•• (see Modicon 
M258, Logic Controller, 
Hardware Guide)

2 1 1 1 1 1

Embedded expert I/O Embedded regular I/O

Fast 
Inputs

Fast 
Outputs

Regular 
Inputs

Digital 
Inputs

Digital 
Outputs

Analog Inputs

TM258LD42DT 
(see Modicon M258, 
Logic Controller, 
Hardware Guide)

2x 5 2 2 1x 12 12 0

TM258LD42DT4L 
(see Modicon M258, 
Logic Controller, 
Hardware Guide)

2x 5 2 2 1x 12 12 4

TM258LF42DT•• 
(see Modicon M258, 
Logic Controller, 
Hardware Guide)

2x 5 2 2 1x 12 12 0

TM258LF42DT4L•• 
(see Modicon M258, 
Logic Controller, 
Hardware Guide)

2x 5 2 2 1x 12 12 4
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TM258LF66DT4L•• 
(see Modicon M258, 
Logic Controller, 
Hardware Guide)

2x 5 2 2 2x 12 12 4

TM258LF42DR•• 
(see Modicon M258, 
Logic Controller, 
Hardware Guide)

2x 5 2 2 2x 6 6 Relays 0

Embedded expert I/O Embedded regular I/O

Fast 
Inputs

Fast 
Outputs

Regular 
Inputs

Digital 
Inputs

Digital 
Outputs

Analog Inputs
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9.2 LMC058 Motion Controllers

Modicon LMC058 Motion Controller

Introduction

Overview

Software configuration and hardware description can be found in the following 
manuals:

Modicon LMC058 Motion Controller programming guide (see Modicon LMC058 
Motion Controller, Programming Guide)
Modicon LMC058 Motion Controller hardware guide (see Modicon LMC058, 
Motion Controller, Hardware Guide)

The Schneider Electric Modicon LMC058 Motion Controller is a controller with a 
variety of powerful features. This controller is the optimized solution for axis 
positioning thanks to software with embedded automation functions and an 
ergonomic interface for axis configuration (SoMachine software). It can control a 
wide range of applications. Combined with Lexium servo drives or Lexium SD3 
Stepper drives, this lets you easily design and commission your applications.

Key Features

The SoMachine software compatible with the controller provides the following 
IEC61131-3 programming languages:

IL: Instruction List
ST: Structured Text
FBD: Function Block Diagram
SFC: Sequential Function Chart
LD: Ladder Diagram
CFC: Continuous Function Chart 

All controllers include:
CANopen Master
Encoder Master
Ethernet
Serial Line
Expert functions (counting, reflex outputs...)
Embedded I/Os
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All controllers support up to 21 tasks with the following limits:
1 motion task synchronized with the CANmotion Master
4 cyclic tasks: one is configured by default (Mast)
1 freewheeling task
8 software event driven tasks
8 hardware event driven tasks
1 hardware event driven task CANmotion Master dedicated to motion device 
synchronization

Controller Range

PCI CAN USB A USB Pgr Eth SL ENC

LMC058LF42•• 
(see Modicon LMC058, 
Motion Controller, Hardware 
Guide)

0 2 1 1 1 1 1

LMC058LF424•• 
(see Modicon LMC058, 
Motion Controller, Hardware 
Guide)

2 2 1 1 1 1 1

Embedded expert I/O Embedded regular I/O

Fast 
Inputs

Fast 
Outputs

Regular 
Inputs

Digital 
Inputs

Digital 
Outputs

Analog Inputs

LMC058LF42•• 
(see Modicon LMC058, 
Motion Controller, 
Hardware Guide)

2x 5 2 2 1x 12 12 0

LMC058LF424•• 
(see Modicon LMC058, 
Motion Controller, 
Hardware Guide)

2x 5 2 2 1x 12 12 4
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9.3 TM5 PCI Modules

TM5 PCI Communication Modules

Introduction

The following paragraph lists the communication modules that are supported by 
SoMachine with their description.

See Modicon TM5 PCI Communication Modules Hardware Guide 
(see Modicon TM5, PCI Modules, Hardware Guide).

Supported Modules

The following table shows the communication module features available with the 
Modicon M258 Logic Controller and the Modicon LMC058 Motion Controller:

NOTE: 

For information on compatibility rules between PCI modules and controllers, refer to:
Modicon M258 Logic Controller Hardware Guide 
Modicon LMC058 Motion Controller Hardware Guide

Reference Description

TM5PCRS2 
(see Modicon TM5, 
PCI Modules, 
Hardware Guide)

TM5 interface module, 1 Serial Line RS232, electrically isolated

TM5PCRS4 
(see Modicon TM5, 
PCI Modules, 
Hardware Guide)

TM5 interface module, 1 Serial Line RS485, electrically isolated

TM5PCDPS TM5 interface module, 1 Profibus DP slave RS485, electrically 
isolated
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9.4 TM5 Expansion Modules

What’s in this Section?

This section contains the following topics:

Topic Page

TM5 Compact I/O Expansion Modules 87

TM5 Digital I/O Expansion Modules 89

TM5 Analog I/O Expansion Modules 91

TM5 Expert (HSC) Expansion Modules 93

TM5 Transmitter and Receiver Modules 94

TM5 Power Distribution Modules (PDM) 95

TM5 Common Distribution Modules (CDM) 96
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TM5 Compact I/O Expansion Modules

Introduction

The following paragraph lists the TM5 Compact I/O modules supported by 
SoMachine with their complete names and catalog references.

See Modicon TM5 Compact I/O Hardware Guide (see Modicon TM5, Compact I/O 
Modules, Hardware Guide).

Supported Modules

The Modicon M258 Logic Controller and the Modicon LMC058 Motion Controller 
support the following I/O modules:

Reference Number and Channel Type

Digital 
Inputs

Digital Outputs Analog Inputs Analog Outputs

TM5C24D18T 
(see Modicon TM5, 
Compact I/O Modules, 
Hardware Guide)

2x12In 24 3x6Out 18 – 0 – 0

TM5C12D8T 
(see Modicon TM5, 
Compact I/O Modules, 
Hardware Guide)

3x4In 12 2x4Out 8 – 0 – 0

TM5C24D12R 
(see Modicon TM5, 
Compact I/O Modules, 
Hardware Guide)

2x12In 24 2x6Rel 12 Relays – 0 – 0

TM5CAI8O8VL 
(see Modicon TM5, 
Compact I/O Modules, 
Hardware Guide)

- 0 - 0 2x4AI ±10 V 8 2x4AO ±10 V 8

TM5CAI8O8CL 
(see Modicon TM5, 
Compact I/O Modules, 
Hardware Guide)

- 0 - 0 2x4AI 0-20 mA / 4-20 mA 8 2x4AO 0-20 mA 8

TM5CAI8O8CVL - 0 - 0 1x4AI ±10 V 4 1x4AO ±10 V 4

1x4AI 0-20 mA / 4-20 mA 4 1x4AO 0-20 mA 4

TM5C12D6T6L 
(see Modicon TM5, 
Compact I/O Modules, 
Hardware Guide)

2x6In 12 1x6Out 6 1x 4AI ±10 V / 0-20 mA / 
4-20 mA 

4 1x2AO ±10 V / 
0-20 mA 

2
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Digital Input and Output Electronic Modules Features

The following table shows the digital input and output electronic modules features, 
with corresponding channel type and voltage/current

Analog Input and Output Electronic Modules Features

The following table shows the analog input and output electronic modules features:

Reference Number of 
Channels

Voltage/Current Wiring Signal Type

Digital Input Electronic Modules

4In (see Modicon TM5, Compact I/O 
Modules, Hardware Guide)

4 24 Vdc / 3.75 mA 3 wires sink

6In (see Modicon TM5, Compact I/O 
Modules, Hardware Guide)

6 24 Vdc / 3.75 mA 2 wires sink

12In (see Modicon TM5, Compact I/O 
Modules, Hardware Guide)

12 24 Vdc / 3.75 mA 1 wire sink

Digital Output Electronic Modules

4Out (see Modicon TM5, Compact I/O 
Modules, Hardware Guide)

4 24 Vdc / 0.5 A 3 wires source

6Out (see Modicon TM5, Compact I/O 
Modules, Hardware Guide)

6 24 Vdc / 0.5 A 2 wires source

Digital Output Relay Electronic Modules

6Rel (see Modicon TM5, Compact I/O 
Modules, Hardware Guide)

6 30 Vdc / 2 A
240 Vac / 2 A

6 normally open 
contacts relays

sink/source

Reference Number of 
Channels

Digital Converter 
Resolution

Voltage/Current

Analog Input Electronic Module

4AI ±10 V (see Modicon TM5, Compact I/O Modules, 
Hardware Guide)

4 12 bit 0...10 Vdc

4AI 0-20 mA / 4-20 mA (see Modicon TM5, Compact 
I/O Modules, Hardware Guide)

4 12 bit 0...20 mA

 4AI ±10 V / 0-20 mA / 4-20 mA  (see Modicon TM5, 
Compact I/O Modules, Hardware Guide)

4 12 bit + sign
12 bit

-10...+10 Vdc
0...20 mA/4...20 mA

Analog Output Electronic Module

4AO ±10 V (see Modicon TM5, Compact I/O Modules, 
Hardware Guide)

4 12 bit 0...10 Vdc

4AO 0-20 mA (see Modicon TM5, Compact I/O 
Modules, Hardware Guide)

4 12 bit 0...20 mA

2AO ±10 V / 0-20 mA  (see Modicon TM5, Compact I/O 
Modules, Hardware Guide)

2 12 bit + sign
12 bit

-10...+10 Vdc
0...20 mA
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TM5 Digital I/O Expansion Modules

Introduction

The following paragraph lists the digital I/O modules supported by SoMachine with 
their complete names and catalog references.

See Modicon TM5 Digital I/O Modules Hardware Guide (see Modicon TM5, Digital 
I/O Modules, Hardware Guide).

Supported Modules

The Modicon M258 Logic Controller and the Modicon LMC058 Motion Controller 
support the following I/O modules:

Reference Number of 
Channels

Voltage/Current

Input Modules

TM5SDI2D 2 24 Vdc / 3.75 mA

TM5SDI4D (see Modicon TM5, Digital 
I/O Modules, Hardware Guide)

4 24 Vdc / 3.75 mA

TM5SDI6D (see Modicon TM5, Digital 
I/O Modules, Hardware Guide)

6 24 Vdc / 3.75 mA

TM5SDI12D (see Modicon TM5, Digital 
I/O Modules, Hardware Guide)

12 24 Vdc / 3.75 mA

TM5SDI2A (see Modicon TM5, Digital 
I/O Modules, Hardware Guide)

2 100...240 Vac

TM5SDI4A (see Modicon TM5, Digital 
I/O Modules, Hardware Guide)

4 100...240 Vac

TM5SDI6U (see Modicon TM5, Digital 
I/O Modules, Hardware Guide)

6 100...120 Vac

Output Modules

TM5SDO2T (see Modicon TM5, Digital 
I/O Modules, Hardware Guide)

2 24 Vdc / 0.5 A

TM5SDO4T (see Modicon TM5, Digital 
I/O Modules, Hardware Guide)

4 24 Vdc / 0.5 A

TM5SDO4TA (see Modicon TM5, Digital 
I/O Modules, Hardware Guide)

4 24 Vdc / 2 A

TM5SDO6T (see Modicon TM5, Digital 
I/O Modules, Hardware Guide)

6 24 Vdc / 0.5 A

TM5SDO8TA (see Modicon TM5, Digital 
I/O Modules, Hardware Guide)

8 24 Vdc / 2 A
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TM5SDO12T (see Modicon TM5, Digital 
I/O Modules, Hardware Guide)

12 24 Vdc / 0.5 A

TM5SDO2R (see Modicon TM5, Digital 
I/O Modules, Hardware Guide)

2 30 Vdc / 230 Vac 5 A C/O

TM5SDO4R (see Modicon TM5, Digital 
I/O Modules, Hardware Guide)

4 30 Vdc 1 A / 230 Vac 5 A N/O

TM5SDO2S (see Modicon TM5, Digital 
I/O Modules, Hardware Guide)

2 230 Vac / 1 A

Mixed Modules

TM5SDM12DT (see Modicon TM5, 
Digital I/O Modules, Hardware Guide)

8
4

24 Vdc / 3.75 mA
24 Vdc / 0.5 A

TM5SMM6D2L 4 digital inputs 24 Vdc / 3.3 mA

2 digital outputs 24 Vdc / 0.5 A

1 analog input -10...+10 Vdc
0...20 mA/4...20 mA

1 analog output -10...+10 Vdc
0...20 mA

Reference Number of 
Channels

Voltage/Current
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TM5 Analog I/O Expansion Modules

Introduction

The following paragraphs list the analog I/O modules supported by SoMachine with 
their complete names and references.

See Modicon TM5 Analog I/O Modules Hardware Guide (see Modicon TM5, Analog 
I/O Modules, Hardware Guide).

Supported Modules

The Modicon M258 Logic Controller and the Modicon LMC058 Motion Controller 
support the following analog I/O modules:

Reference Number of 
Channels

Digital 
Converter 
Resolution

Voltage/Current

Input Modules

TM5SAI2L (see Modicon 
TM5, Analog I/O Modules, 
Hardware Guide)

2 12 bit + sign
12 bit

-10...+10 Vdc
0...20 mA/4...20 mA

TM5SAI4L (see Modicon 
TM5, Analog I/O Modules, 
Hardware Guide)

4 12 bit + sign
12 bit

-10...+10 Vdc
0...20 mA/4...20 mA

TM5SAI2H (see Modicon 
TM5, Analog I/O Modules, 
Hardware Guide)

2 15 bit + sign
15 bit

-10...+10 Vdc
4...20 mA

TM5SAI4H (see Modicon 
TM5, Analog I/O Modules, 
Hardware Guide)

4 15 bit + sign
15 bit

-10...+10 Vdc
4...20 mA

TM5SEAISG 1 24 bit 1 full bridge strain gauge

Output Modules

TM5SAO2L (see Modicon 
TM5, Analog I/O Modules, 
Hardware Guide)

2 12 bit + sign
12 bit

-10...+10 Vdc
0...20 mA

TM5SAO4L (see Modicon 
TM5, Analog I/O Modules, 
Hardware Guide)

4 12 bit + sign
12 bit

-10...+10 Vdc
0...20 mA

TM5SAO2H (see Modicon 
TM5, Analog I/O Modules, 
Hardware Guide)

2 15 bit + sign
15 bit

-10...+10 Vdc
0...20 mA

TM5SAO4H (see Modicon 
TM5, Analog I/O Modules, 
Hardware Guide)

4 15 bit + sign
15 bit

-10...+10 Vdc
0...20 mA
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The Modicon M258 Logic Controller and the Modicon LMC058 Motion Controller 
support the following analog temperature modules:

Reference Number of 
Channels

Digital Converter 
Resolution

Sonde Type

TM5SAI2PH (see Modicon 
TM5, Analog I/O Modules, 
Hardware Guide)

2 16 bit PT100/1000

TM5SAI4PH (see Modicon 
TM5, Analog I/O Modules, 
Hardware Guide)

4 16 bit PT100/1000

TM5SAI2TH (see Modicon 
TM5, Analog I/O Modules, 
Hardware Guide)

2 16 bit Thermocouple J, K, N, S

TM5SAI6TH (see Modicon 
TM5, Analog I/O Modules, 
Hardware Guide)

6 16 bit Thermocouple J, K, N, S
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TM5 Expert (HSC) Expansion Modules

Introduction

The following paragraph lists the expert (for high-speed counting) modules that are 
supported by SoMachine with their description.

See Modicon TM5 Expert (HSC) Modules Hardware Guide (see Modicon TM5, 
Expert (High Speed Counter) Modules, Hardware Guide).

Supported Modules

The Modicon M258 Logic Controller and the Modicon LMC058 Motion Controller 
support the following I/O modules:

Reference Number 
Channels

Encoder Type Encoder Inputs Counter 
Resolution

Input 
Frequency

TM5SE1IC02505 
(see Modicon TM5, Expert 
(High Speed Counter) 
Modules, Hardware Guide)

1 Incremental 5 Vdc Symmetrical 16/32 bit 250 kHz

TM5SE1IC01024 
(see Modicon TM5, Expert 
(High Speed Counter) 
Modules, Hardware Guide)

1 Incremental 24 Vdc Asymmetrical 16/32 bit 100 kHz

TM5SE2IC01024 
(see Modicon TM5, Expert 
(High Speed Counter) 
Modules, Hardware Guide)

2 Incremental 24 Vdc Asymmetrical 16/32 bit 100 kHz

TM5SE1SC10005 
(see Modicon TM5, Expert 
(High Speed Counter) 
Modules, Hardware Guide)

1 SSI Absolute 5 Vdc Symmetrical 32 bit 1 MHz

TM5SDI2DF (see Modicon 
TM5, Expert (High Speed 
Counter) Modules, 
Hardware Guide)

2 – Gate measurement event 
counter

– –
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TM5 Transmitter and Receiver Modules

Introduction

The following paragraph lists the transmitter and receiver expansion modules that 
are supported by SoMachine with their descriptions.

The transmitter and receiver modules are described in the Modicon TM5 Transmitter 
and Receiver Modules Hardware Guide (see Modicon TM5, Transmitter and 
Receiver Modules, Hardware Guide).

Supported Modules

The following table shows the TM5 transmitter and receiver modules features 
available with the Modicon M258 Logic Controller and the 
Modicon LMC058 Motion Controller:

Module Module Description

TM5SBET1 (see Modicon TM5, Transmitter 
and Receiver Modules, Hardware Guide)

Transmits the TM5 data bus.

TM5SBET7 (see Modicon TM5, Transmitter 
and Receiver Modules, Hardware Guide)

Transmits the TM7 data bus and provides the 
TM7 power bus to the TM7 expansion I/O 
blocks.

TM5SBER2 (see Modicon TM5, Transmitter 
and Receiver Modules, Hardware Guide)

Receives the TM5 data bus, provides power 
to the 24 Vdc I/O power segment and 
provides the TM5 power bus to the TM5 
expansion I/O modules.
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TM5 Power Distribution Modules (PDM)

Introduction

The following paragraph lists the power distribution modules that are supported by 
SoMachine with their descriptions.

The power distribution modules are described in the Modicon TM5 System Planning 
and Installation Guide (see Modicon TM5 / TM7 Flexible System, System Planning 
and Installation Guide).

Supported Modules

The following table shows the TM5 Power Distribution Modules (PDM) features 
available with the Modicon M258 Logic Controller and the 
Modicon LMC058 Motion Controller:

Reference Rated Power 
Supply Source

Maximum 
Current 
Provided on the 
24 Vdc I/O Power 
Segment

TM5 power 
Bus Current 
Generated

TM5 Power Distribution Modules

TM5SPS1 (see Modicon TM5 / TM7 
Flexible System, System Planning 
and Installation Guide)

24 Vdc 10 A No

TM5SPS1F (see Modicon 
TM5 / TM7 Flexible System, System 
Planning and Installation Guide)

24 Vdc 6.3 A No

TM5SPS2 (see Modicon TM5 / TM7 
Flexible System, System Planning 
and Installation Guide)

24 Vdc 10 A 1.136 A

TM5SPS2F (see Modicon 
TM5 / TM7 Flexible System, System 
Planning and Installation Guide)

24 Vdc 6.3 A 1.136 A
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TM5 Common Distribution Modules (CDM)

Introduction

The following paragraph lists the common distribution modules that are supported 
by SoMachine with their descriptions.

The common distribution modules are described in the Modicon TM5 System 
Planning and Installation Guide (see Modicon TM5 / TM7 Flexible System, System 
Planning and Installation Guide).

Supported Modules

The following table shows the TM5 Common Distribution Modules (CDM) features 
available with the Modicon M258 Logic Controller and the 
Modicon LMC058 Motion Controller:

Reference Rated 24 Vdc Rated 0 Vdc Power Supply 
Source

TM5 Common Distribution Modules

TM5SPDG12F 0 12 24 Vdc I/O power 
segment

TM5SPDD12F (see Modicon 
TM5 / TM7 Flexible System, System 
Planning and Installation Guide)

12 0 24 Vdc I/O power 
segment

TM5SPDG5D4F (see Modicon 
TM5 / TM7 Flexible System, System 
Planning and Installation Guide)

5 5 External 24 Vdc 
power source

TM5SPDG6D6F 6 6 24 Vdc I/O power 
segment
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9.5 TM7 Expansion Blocks

What’s in this Section?

This section contains the following topics:

Topic Page

TM7 Digital I/O Blocks 98

TM7 Analog I/O Blocks 99
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TM7 Digital I/O Blocks

Introduction

The following paragraph lists the TM7 digital I/O blocks supported by SoMachine 
with their complete names and catalog references.

See Modicon TM7 Digital I/O Blocks Hardware Guide (see Modicon TM7, Digital I/O 
Blocks, Hardware Guide).

Supported Blocks

The Modicon M258 Logic Controller and the Modicon LMC058 Motion Controller 
support the following I/O blocks:

Reference Number of 
Channels

Voltage/Current Wiring

Input Blocks

TM7BDI8B (see Modicon TM7, 
Digital I/O Blocks, 
Hardware Guide)

8 24 Vdc / 7 mA M8 connectors

TM7BDI16A (see Modicon TM7, 
Digital I/O Blocks, 
Hardware Guide)

16 24 Vdc / 7 mA M12 connectors

TM7BDI16B (see Modicon TM7, 
Digital I/O Blocks, 
Hardware Guide)

16 24 Vdc / 7 mA M8 connectors

Output Block

TM7BDO8TAB (see Modicon 
TM7, Digital I/O Blocks, 
Hardware Guide)

8 24 Vdc / 2 A max. M8 connector

Mixed Input/Output Blocks

TM7BDM8B (see Modicon TM7, 
Digital I/O Blocks, 
Hardware Guide)

8 configurable 
I/O, any mix

24 Vdc / 4.4 mA M8 connector

24 Vdc / 0.5 A max. M8 connector

TM7BDM16A  (see Modicon 
TM7, Digital I/O Blocks, 
Hardware Guide)

16 inputs 24 Vdc / 4.4 mA M12 connector

16 outputs 24 Vdc / 0.5 A max. M12 connector

TM7BDM16B  (see Modicon 
TM7, Digital I/O Blocks, 
Hardware Guide)

16 inputs 24 Vdc / 4.4 mA M8 connector

16 outputs 24 Vdc / 0.5 A max. M8 connector
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TM7 Analog I/O Blocks

Introduction

The following paragraphs list the TM7 analog I/O blocks supported by SoMachine 
with their complete names and references.

See Modicon TM7 Analog I/O Blocks Hardware Guide (see Modicon TM7, Analog 
I/O Blocks, Hardware Guide).

Supported Blocks

The Modicon M258 Logic Controller and the Modicon LMC058 Motion Controller 
support the following analog I/O blocks:

Reference Number of 
Channels

Digital 
Converter 
Resolution

Voltage/Current Sensor/Actuator 
Connectors

Input Blocks

TM7BAI4VLA 
(see Modicon TM7, 
Analog I/O Blocks, 
Hardware Guide)

4 11 bit + sign -10...+10 Vdc M12

TM7BAI4CLA 
(see Modicon TM7, 
Analog I/O Blocks, 
Hardware Guide)

4 12 bit 0...20 mA M12

Output Blocks

TM7BAO4VLA 
(see Modicon TM7, 
Analog I/O Blocks, 
Hardware Guide)

4 11 bit + sign -10...+10 Vdc M12

TM7BAO4CLA 
(see Modicon TM7, 
Analog I/O Blocks, 
Hardware Guide)

4 12 bit 0...20 mA M12

Mixed Input/Output Blocks

TM7BAM4VLA 
(see Modicon TM7, 
Analog I/O Blocks, 
Hardware Guide)

2 inputs 11 bit + sign -10...+10 Vdc M12

2 outputs 11 bit + sign -10...+10 Vdc M12

TM7BAM4CLA 
(see Modicon TM7, 
Analog I/O Blocks, 
Hardware Guide)

2 inputs 12 bit 0...20 mA M12

2 outputs 12 bit 0...20 mA M12
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The Modicon M258 Logic Controller and the Modicon LMC058 Motion Controller 
support the following analog temperature blocks:

Reference Number of 
Channels

Digital 
Converter 
Resolution

Sonde Type Sensor 
Connectors

TM7BAI4TLA 
(see Modicon TM7, 
Analog I/O Blocks, 
Hardware Guide)

4 16 bit PT100 / 1000
KTY10 / KTY84 
(Silicon sensor)

M12

TM7BAI4PLA 
(see Modicon TM7, 
Analog I/O Blocks, 
Hardware Guide)

4 16 bit Thermocouple J, K, S M12
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10.1 HMI Terminal Range

What’s in this Section?

This section contains the following topics:

Topic Page

XBTGT HMI Terminals 102

XBTGK HMI Terminals 104

XBTGH HMI Terminal 105

HMI Small Terminals 106

Magelis GTO Terminals 107
101
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XBTGT HMI Terminals

Introduction

The following paragraph lists the XBTGT HMI terminal families supported by 
SoMachine.

The XBTGT HMI terminals can be configured as a controller when a CANopen unit 
(XBTZGCANM) is connected to it.

The XBTZGCANM unit is compatible with: 
XBTGT 2•••
XBTGT 4•••
XBTGT 5•••
XBTGT 6•••
XBTGT 7•••

NOTE: The XBTGT 1••• is not compatible with the XBTZGCANM unit.

For detailed information see the Vijeo-Designer online help.

XBTGT HMI Touch Panel Terminal Range

The following table describes the XBTGT HMI HMI terminals: 

HMI Terminals Display Type Screen Size Video 
Port

Ethernet 
Interface

Serial 
Interface

USB 
Interface

CF Card 
Interface

XBTGT1100 QVGA/STN Amber 9,6 cm (3.8 in) No No Yes (1) No No

XBTGT 1105 QVGA/STN Amber 9,6 cm (3.8 in) No No Yes (1) Yes No

XBTGT1130 QVGA/STN Amber 9,6 cm (3.8 in) No Yes Yes (1) No No

XBTGT 1135 QVGA/STN Amber 9,6 cm (3.8 in) No Yes Yes (1) Yes No

XBTGT 1335 QVGA/STN Amber 9,6 cm (3.8 in) No Yes Yes (1) Yes No

XBTGT 2110 QVGA/STN 
Monochrome

14,4 cm (5.7 in) No No Yes (2) Yes No

XBTGT 2120 QVGA/STN 
Monochrome

14,4 cm (5.7 in) No No Yes (2) Yes Yes

XBTGT 2130 QVGA/STN 
Monochrome

14,4 cm (5.7 in) No Yes Yes (2) Yes Yes

XBTGT 2220 QVGA/STN Color 14,4 cm (5.7 in) No No Yes (2) Yes Yes

XBTGT 2330 QVGA/TFT Color 14,4 cm (5.7 in) No Yes Yes (2) Yes Yes

XBTGT 4230 VGA/STN Color 14,4 cm (5.7 in) No Yes Yes (2) Yes Yes

XBTGT 4330 VGA/TFT Color 14,4 cm (5.7 in) No Yes Yes (2) Yes Yes
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XBTGT 4340 VGA/TFT Color 19,1 cm (7.5 in) No Yes Yes (2) Yes Yes

XBTGT 5230 VGA/STN Color 19,1 cm (7.5 in) No Yes Yes (2) Yes Yes

XBTGT 5330 VGA/TFT Color 19,1 cm (7.5 in) Yes Yes Yes (2) Yes Yes

XBTGT 5340 VGA/TFT Color 26,4 cm (10.4 in) No Yes Yes (2) Yes Yes

XBT GT 6330 SVGA/TFT Color 26,4 cm (10.4 in) No Yes Yes (2) Yes Yes

XBTGT 6340 SVGA/TFT Color 26,4 cm (10.4 in) Yes Yes Yes (2) Yes Yes

XBTGT 7340 XGA/TFT Color 26,4 cm (10.4 in) No Yes Yes (2) Yes Yes

Legend

1 RS232/RS485 serial interface RJ45 connector

2 RS232/RS422/RS485 serial interface SUB-D 9-pin connector and RS485 serial interface RJ45 pin 
connector

HMI Terminals Display Type Screen Size Video 
Port

Ethernet 
Interface

Serial 
Interface

USB 
Interface

CF Card 
Interface
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XBTGK HMI Terminals

Introduction

The following paragraph lists the XBTGK HMI terminal families supported by 
SoMachine.

The XBTGK HMI terminal can be configured as a controller when a CANopen unit 
(XBTZGCANM) is connected to it.

The XBTZGCANM unit is compatible with:
XBTGK 2•••
XBTGK 5•••

For detailed information see the Vijeo-Designer online help.

XBTGK HMI Touch and Keyboard Terminal Range

The following table describes the XBTGK HMI HMI terminals:

HMI
Terminals

Display Type Screen Size Video 
Port

Ethernet 
Interface

Serial 
Interface

USB 
Interface

CF Card 
Interface

XBTGK 2120 QVGA/STN 
Monochrome

14,4 cm (5.7 in) No No Yes (1) Yes Yes

XBTGK 2330 QVGA/TFT 
Color

14,4 cm (5.7 in) No Yes Yes (1) Yes Yes

XBTGK 5330 VGA/TFT Color 26,4 cm (10.4 in) No Yes Yes (1) Yes Yes

Legend

1 RS232/RS422/RS485 serial interface. SUB-D 9-pin connector and RS485 RJ45 connector
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XBTGH HMI Terminal

Introduction

The following paragraph lists the XBTGH HMI terminal families supported by 
SoMachine.

XBTGH HMI Terminal

The following table presents the different XBTGH HMI terminal: 

HMI Terminal Screen Size Pixel 
Resolution

Mono/Color Screen 
Technology

Video 
Port

Ethernet 
Port

Serial 
Interface

XBTGH2460 14,4 cm (5.7 in) VGA Color TFT No Yes Yes (1)

Legend

1 RS232/RS422/RS485 serial interface SUB-D 9-pin connector
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HMI Small Terminals

HMI STU 655 / 855 Series of Panels

The HMI STU 655 / 855 is a Human Machine Interface product that has an operating 
voltage of 24 Vdc.

The following table describes the HMI STU 655 / 855 characteristics:

HMI STO 5•• Series of Panels

The following presents the HMI STO 5•• series of HMI (Human Machine Interface) 
products. These products have an operating voltage of 24 Vdc.

The products offered in this series have various features and benefits listed below:
screen size
screen resolution
screen technology and color
communication ports

The following table describes the different HMI STO products:

NOTE: The HMI STO 501 is not included in the list of devices of SoMachine.

Part Number Screen Size Screen (Pixel) 
Resolution

Mono / Color Screen 
Technology

Serial Port Ethernet 
Port

HMI STU 655 8.9 cm (3.5 in.) 320x240 (QVGA) 65 K colors and 
LED’s backlight

TFT yes yes

HMI STU 855 14.48 cm (5.7 in.) 320x240 (QVGA) 65 K colors and 
LED’s backlight

TFT yes yes

TFT: Thin-film Transistor Technology

Part Number Screen Size Screen 
(Pixel) 
Resolution

Mono / Color Screen 
Technology

Serial Port Ethernet 
Port

HMI STO 511/531 8.9 cm (3.5 in.) 200x80 monochrome with 
green / orange / red 
backlight

STN yes no for 511
yes for 531

HMI STO 512/532 8.9 cm (3.5 in.) 200x80 monochrome with 
white / pink / red 
backlight

STN yes no for 512
yes for 532

STN: scan twisted neumatic, also known as passive matrix
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Magelis GTO Terminals

Introduction

The following paragraph lists the Magelis GTO terminal families supported by 
SoMachine.

For detailed information see the Vijeo-Designer online help.

Magelis GTO Touch Panel Terminal Range

The following table describes the Magelis GTO HMI terminals: 

HMI Terminals Display Type Screen Size Ethernet 
Interface

Serial 
Interface

USB 
Interface

SD Card 
Interface

HMI GTO1300 TFT Color LCD 8,9 cm (3.5 in) No Yes Yes No

HMI GTO1310 TFT Color LCD 8,9 cm (3.5 in) Yes Yes Yes No

HMI GTO 2300 TFT Color LCD 14,4 cm (5.7 in) No Yes Yes No

HMI GTO 2310/2315 TFT Color LCD 14,4 cm (5.7 in) No Yes Yes Yes

HMI GTO 3510 TFT Color LCD 19,1 cm (7.5 in) Yes Yes Yes Yes

HMI GTO 4310 TFT Color LCD 17,8 cm (7 in) Yes Yes Yes Yes

HMI GTO 5310/5315 TFT Color LCD 26,4 cm (10.4 in) Yes Yes Yes Yes

HMI GTO 6310/6315 TFT Color LCD 30,7 cm (12.1 in) Yes Yes Yes Yes
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Overview

SoMachine offers a list of various devices ready to be connected to the controllers 
through a fieldbus. This list can be extended with other devices using the Device 
Repository editor. 

What’s in this Chapter?

This chapter contains the following topics:

Topic Page

Motor Control 110

Distributed I/O Modules 112

Other Distributed Devices 114
109
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Motor Control

TeSys U

TeSys U is a range of motor controller-starter up to 32 A / 15 kW that consists of:
one 45 mm power base: 2 ratings, reversing or non-reversing, circuit-breaker 
functions and built-in interference suppression
one clip-on control unit (CU), from a choice of 3

Standard CU (protections against overloads and short-circuits)
Expandable CU (with additional alarm and fault differentiation)
Multifunction CU (realtime control of motor load, local or remote diagnostics 
and parameter setting)

one clip-on automation control module for fieldbus connection: Modbus, 
CANopen, AS-Interface, etc.
two optional 45 mm power functions

limiter-isolator
changeover relay

TeSys T

TeSys T is a Motor Management System that comprises:
a controller providing main protection and control functions
an extension module that completes the functions of the controller by the voltage 
protection and monitoring
an operator control unit for reading, diagnostics and modification of the 
parameters monitored

TeSys T incorporates a communication interface for remote supervision and control 
of the motor on Modbus, CANopen, etc.

Altivar

Altivar is the range of variable speed drives for motor control.

Altivar drives offer Modbus and CANopen embedded communication.
ATV31 and ATV312: 3-phase asynchronous motors 0.18 to 15 kW
ATV71: 3-phase synchronous and asynchronous motors from 0.37 to 630 kW
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Lexium

Lexium is the range of drives for motion control that can be connected to CANopen 
and other fieldbusses.

Lexium SD3: drives for stepper motor control
Integrated Lexium: integrated drives for motion control, with servo-(ILA range), 
stepper- (ILS range) or brushless DC (ILE range) motor
Lexium05: optimized servo drives for servo motors from 0.4 to 6 kW
Lexium32: high-performance book-size servo drives for servo motors from 0.15 
to 7 kW
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Distributed I/O Modules

Advantys OTB

The Advantys OTB solution is an optimized and economical IP20 I/O system. The 
OTB network interface module with built-in inputs and outputs connects to the 
CANopen fieldbus and accepts up to 7 TM2 I/O expansion modules.

NOTE: 

Advantys OTB offers 2 other references with the same I/O characteristics:
OTB1E0DM9LP: Ethernet Modbus TCP network interface module
OTB1S0DM9LP: Modbus Serial network interface module

Advantys FTB

Advantys FTB is an IP67 distributed monoblock I/O modules offering a large 
selection of 16 channels compositions (8 M12 connectors) that connect to 
CANopen.

Reference Channel Type of Channel Input/Output Type Power Supply

OTB1C0DM9LP 12 inputs 24 VDC 24 VDC

6 outputs relay 24 VDC

2 outputs 24 VDC source 
transistor

24 VDC

Reference Type Input Channels Output Channels In/Out Channels

FTB1CN08E08SP0 Plastic 8 8 –

FTB1CN12E04SP0 Plastic 12 4 –

FTB1CN16EP0 Plastic 16 – –

FTB1CN16EM0 Metal 16 – –

FTB1CN16CP0 Plastic – – 16

FTB1CN16CM0 Metal – – 16

FTB1CN08E08CM0 Metal 8 – 8
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AS-Interface Devices

A complete set of devices can be connected to AS-Interface:
IP20 distributed I/Os Advantys interface ASI 20M range
IP67 distributed I/Os Advantys interface ASI 67F range
TeSys U motor controller-starter ASI LUF range
Direct Motor Starter LF range
Control station Harmony XALS range
Illuminated indicator bank XVBC range
Safety Monitors ASI SAFEMON••
Safety Interfaces ASI S••••
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Other Distributed Devices

Encoder

OsiCoder (OsiSense XCC offer) is a range of rotary encoders. 

Absolute multiturn encoders can be connected to CANopen for absolute position 
and speed reading.

Safety Controller

Preventa XPSMC is a range of configurable safety controllers:
Category 4 conforming to IEC 947-1 and SIL3 conforming to EN 61508
16 and 32 input versions
4 (2 x 2 NO) relay outputs and 6 solid-state outputs
30 certified safety functions in order to respond to specific application 
requirements
communication to logic controllers via Modbus, CANopen etc.
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Overview

This section provides the annexes regarding the compatibility between SoMachine 
versions.

What’s in this Chapter?

This chapter contains the following topics:

Topic Page

Compatibility of Controller and Device Description Versions 118

Compatibility of HMI and Controller Versions 119

Compatibility of SoMachine and Vijeo-Designer Versions 120
117
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Compatibility of Controller and Device Description Versions

Overview

Logic controller firmware and device description versions are made of 4 digits: 
X.Y.Z.T. 

A compatible controller firmware with a device description means an Application.app 
file can be downloaded to controller.

Compatilibity Rule 

The controller firmware and the device description are compatible if the following 
rules are respected: 

X.Y digits must be identical 
The Z digit of the controller must be greater or equal to the Z digit from the device 
description. 
T digit is irrelevant

Example

a device description version 2.0.20.30 of an M238 controller is compatible with the 
following controller firmware versions:

2.0.20.11
2.0.20.14
2.0.20.30
2.0.30.13
2.0.31.3

But it is not compatible with the firmware versions 2.0.10.8.
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Compatibility of HMI and Controller Versions

Overview

When building a solution with some HMI and controllers communicating to each 
other, we recommend controllers and HMI devices to be at the same firmware / 
runtime compatibility level.

These firmware versions should be the ones used in the SoMachine version in which 
you built and download into controllers and HMI.

When you download an application with an HMI from SoMachine, the HMI runtime 
is automatically updated to the latest version.

The following table provides the relation between the SoMachine version, the 
controller firmware and the HMI runtime:

NOTICE
COMMUNICATION INTERRUPTION

Do not use a different controller firmware version or a different HMI runtime other 
than that which is specified in the table below for the given SoMachine version.

Failure to follow these instructions can result in equipment damage.

SoMachine version used V2.0 RL1 V2.0 RL2 V2.0 RL2 V3.0

HMI runtime V5.1.1.1179 V5.1.11.1200 V5.1.20.1404 V6.0.0.212

M238 firmware version V2.0.20.11 V2.0.20.14 V2.0.20.30 V2.0.30.13

M258 firmware version V2.0.1.2 V2.0.1.14 V2.0.1.36 V2.0.2.32

LMC058 firmware version V2.0.1.2 V2.0.1.14 V2.0.1.36 V2.0.2.32

ATV IMC firmware version V1.1ie01 V1.1ie01 V1.1ie03 V1.1ie19 patch 2
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Compatibility of SoMachine and Vijeo-Designer Versions

Overview

If you want to use Vijeo-Designer with SoMachine, you should not use a different 
version from the one provided with SoMachine.

The following table gives the Vijeo-Designer for each SoMachine version:

If you have a standalone installation of Vijeo-Designer on your computer prior to the 
one provided with SoMachine V3.1 installation, SoMachine installation will 
automatically upgrade your Vijeo-Designer version by uninstalling your previous 
version of Vijeo-Designer and installing the new one.

NOTE: Vijeo-Designer service pack can be installed without creating compatibility 
issue with SoMachine.

SoMachine 
Version

V1.0 V1.1 V2.0 RL1 V2.0 RL2 V3.0

Vijeo-Designer 
Version

5.0.1 5.0.2 5.1 S20R8 5.1 S20R9 6.0
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0-9

%I
According to the IEC standard, %I represents an input bit (for example a language 
object of type digital IN).

%IW
According to the IEC standard, %IW represents an input word register (for example 
a language object of type analog IN).

%MW
According to the IEC standard, %MW represents a memory word register (for 
example a language object of type memory word).

%Q
According to the IEC standard, %Q represents an output bit (for example a language 
object of type digital OUT).

%QW
According to the IEC standard, %QW represents an output word register (for 
example a language object of type analog OUT).

1-phase counter
A 1-phase counter uses 1 hardware input as counter input. It usually counts up or 
counts down when there is pulse signal in the input.
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2-phase counter
A 2-phase counter uses the phase difference between 2 input counter signals to 
count up or count down.

A

ADC
analog/digital converter

AFB
application function block

AMOA
An address of modbus of option application board installed on the drive.

analog input
An analog input module contains circuits that convert an analog DC input signal to 
a digital value that can be manipulated by the processor. By implication, the analog 
input is usually direct. That means a data table value directly reflects the analog 
signal value. 

analog output
An analog output module contains circuits that transmit an analog DC signal 
proportional to a digital value input to the module from the processor. By implication, 
these analog outputs are usually direct. That means a data table value directly 
controls the analog signal value.

application source
The application source file can be uploaded to the PC to reopen a SoMachine 
project. This source file can support a full SoMachine project (for example, one that 
includes HMI application).

ARP
The address resolution protocol is the IP network layer protocol for Ethernet that 
maps an IP address to a MAC (hardware) address.
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ARRAY
An ARRAY is a table containing elements of a single type. The syntax is as follows: 
ARRAY [<limits>] OF <Type>

Example 1: ARRAY [1..2] OF BOOL is a 1-dimensional table with 2 elements of 
type BOOL.

Example 2: ARRAY [1..10, 1..20] OF INT is a 2-dimensional table with 10x20 
elements of type INT.

ARW
anti-reset windup

ASCII
The american standard code for information interchange is a communication 
protocol for representing alphanumeric characters (letters, numbers, and certain 
graphic and control characters).

assigned variable
A variable is "assigned" if its location in controller memory can be known. For 
example, the Water_pressure variable is said to be assigned through its 
association with memory location %MW102.Water_pressure.

ATC
analog tension control

ATV
ATV is the model prefix for Altivar drives. (For example, “ATV312” refers to the 
Altivar 312 variable speed drive.)

AWG
The american wire gauge standard specifies wire gauges in North America.

B

BCD
The binary coded decimal format represents decimal numbers between 0 and 9 with 
a set of 4 bits (a nybble/nibble, also titled as Halfbyte). In this format, the 4 bits used 
to encode decimal numbers have an unused range of combinations. For example, 
the number 2,450 is encoded as 0010 0100 0101 0000
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BOOL
A Boolean type is the basic data type in computing. A BOOL variable can have one 
of these values: 0 (FALSE), 1 (TRUE). A bit that is extracted from a word is of type 
BOOL, for example: %MW10.4 is a fifth bit a memory word number 10.

Boot application
Files that contain machine dependent parameters:

machine name
device name or IP address
Modbus Serial Line address
Routing table

BOOTP
The bootstrap protocol is a UDP network protocol that can be used by a network 
client to automatically obtain an IP address (and possibly other data) from a server. 
The client identifies itself to the server using the client MAC address. The server—
which maintains a pre-configured table of client device MAC addresses and 
associated IP addresses—sends the client its pre-configured IP address. BOOTP 
was originally used as a method that enabled diskless hosts to be remotely booted 
over a network. The BOOTP process assigns an infinite lease of an IP address. The 
BOOTP service utilizes UDP ports 67 and 68.

bps
bit per second as a definition of transmission rate, also given in conjunction with 
multiplicator kilo (kbps) and mega (mbps).

BSH
BSH is a Lexium servo motor from Schneider Electric.

bus base
A bus base is a mounting device that is designed to seat an electronic module on a 
DIN rail and connect it to the TM5 bus for M258 and LMC058 controllers. Each base 
bus extends the TM5 data and to the power buses and the 24 Vdc I/O power 
segment. The electronic modules are added to the TM5 system through their 
insertion on the base bus. The base bus also supplies the articulation point for the 
terminal blocks.
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BYTE
When 8 bits are grouped together, they are called a BYTE. You can enter a BYTE 
either in binary mode or in base 8. The BYTE type is encoded in an 8-bit format that 
ranges from 16#00 to 16#FF (in hexadecimal format).

C

calibration
Graduates a piece of measuring apparatus.

CAN
The controller area network protocol (ISO 11898) for serial bus networks is designed 
for the interconnection of smart devices (from multiple manufacturers) in smart 
systems for real-time industrial applications. Originally developed for use in 
automobiles, CAN is now used in a variety of industrial automation control 
environments.

CANmotion
CANmotion is a CANopen-based motion bus with an additional mechanism that 
provides synchronization between the motion controller and the drives.

CANopen
CANopen is an open industry-standard communication protocol and device profile 
specification.

CFC
The continuous function chart (an extension of the IEC61131-3 standard) is a 
graphical programming language that works like a flowchart. By adding simple logic 
blocks (AND, OR, etc.), each function or function block in the program is 
represented in this graphical format. For each block, the inputs are on the left and 
the outputs on the right. Block outputs can be linked to inputs of other blocks in order 
to create complex expressions.

CiA
CAN in automation is a non-profit group of manufacturers and users dedicated to 
developing and supporting CAN-based higher layer protocols. 
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CIP
When the common industrial protocol is implemented in a network application layer, 
it can communicate seamlessly with other CIP-based networks without regard to the 
protocol. For example, the implementation of CIP in the application layer of an 
Ethernet TCP/IP network creates an EtherNet/IP environment. Similarly, CIP in the 
application layer of a CAN network creates a DeviceNet environment. In that case, 
devices on the EtherNet/IP network can communicate with devices on the 
DeviceNet network through CIP bridges or routers.

CMU
The current measurement unit is used to convert the relative current value (%) 
provided by TeSys into a real ISO value (A).

configuration
The configuration includes the arrangement and interconnection of hardware 
components within a system and the hardware and software selections that 
determine the operating characteristics of the system.

controller
A controller (or “programmable logic controller,” or “programmable controller”) is 
used to automate industrial processes.

controller status output
The controller status output is a special function used in circuits that are external to 
the controller that control the power supply to the output devices or the controller 
power supply.

CPDM
controller power distribution module

CRC
A network message’s cyclic redundancy check field contains a small number of bits 
that produce a checksum. The message is calculated by the transmitter according 
to the message’s content. Receiving nodes then recalculate the field. Any 
discrepancy in the two CRC fields indicates that the transmitted message and the 
received message are different.

CSA
The canadian standards association defines and maintains standards for industrial 
electronic equipment in hazardous environments.
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CTS
Clear to send is a data transmission signal and acknowledges the RDS signal from 
the transmitting station.

cyclic task
The cyclic scan time has a fixed duration (interval) specified by the user. If the 
current scan time is shorter than the cyclic scan time, the controller waits until the 
cyclic scan time has elapsed before starting a new scan.

D

data log
The controller logs events relative to the user application in a data log.

DCE
Data communications equipment describes devices (often modems) that start, stop, 
and sustain network sessions.

Derating
Derating describes a reduction in an operating specification. For devices in general 
it is usually a specified reduction in nominal power to facilitate operation at increased 
ambient conditions like higher temperatures or higher altitudes.

DHCP
The dynamic host configuration protocol is an advanced extension of BOOTP. 
DHCP is a more advanced, but both DHCP and BOOTP are common. (DHCP can 
handle BOOTP client requests.)

digital I/O
A digital input or output has an individual circuit connection at the electronic module 
that corresponds directly to a data table bit that holds the value of the signal at that 
I/O circuit. It gives the control logic digital access to I/O values.

DIN
Deutsches Institut für Normung is a German institution that sets engineering and 
dimensional standards.
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DINT
A double integer type is encoded in a 32-bit format.

DNS
The domain name system is the naming system for computers and devices 
connected to a LAN or the Internet.

drop cable
A drop cable is the unterminated derivation cord used to connect a TAP to a device.

DSR
Data set ready is a data transmission signal.

DTM
With device type managers representing the field device in SoMachine, direct 
communications are possible to every single field device via SoMachine, the 
controller and the field bus, thus avoiding the need for individual cable connections.

DWORD
A double word type is encoded in a 32-bit format.

E

EDS
Electronic data sheet contains for example the properties of a device e.g. 
parameters and settings of a drive.

EEPROM
Electrically erasable programmable read-only memory is a type of non-volatile 
memory used to store data that must be saved when power is removed.

EIA
The electronic industries alliance is the trade organization for establishing 
electrical/electronic and data communication standards (including RS-232 and RS-
485) in the United States.
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EIA rack
An electronic industries alliance rack is a standardized (EIA 310-D, IEC 60297 and 
DIN 41494 SC48D) system for mounting various electronic modules in a stack or 
rack that is 19 inches (482.6 mm) wide.

electronic module
In a programmable controller system, most electronic modules directly interface to 
the sensors, actuators, and external devices of the machine/process. This electronic 
module is the component that mounts in a bus base and provides electrical 
connections between the controller and the field devices. Electronic modules are 
offered in a variety of signal levels and capacities. (Some electronic modules are not 
I/O interfaces, including power distribution modules and transmitter/receiver 
modules.)

EN
EN identifies one of many European standards maintained by CEN (European 
Committee for Standardization), CENELEC (European Committee for 
Electrotechnical Standardization), or ETSI (European Telecommunications 
Standards Institute).

encoder
An encoder is a device for length or angular measurement (linear or rotary 
encoders).

Equipment
An Equipment is a part of the Machine.

ERC
eccentric roller conveyor

ESD
electrostatic discharge

Ethernet
Ethernet is a physical and data link layer technology for LANs, also known as 
IEE 802.3.
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EtherNet/IP
The ethernet industrial protocol is an open communications protocol for 
manufacturing automation solutions in industrial systems. EtherNet/IP is in a family 
of networks that implements Common Industrial Protocol at its upper layers. The 
supporting organization (ODVA) specifies EtherNet/IP to accomplish global 
adaptability and media independence.

expansion bus
The expansion bus is an electronic communication bus between expansion modules 
and a CPU.

expansion I/O module
An expansion input or output module is either a digital or analog module that adds 
additional I/O to the base controller.

expert I/O
Expert I/Os are dedicated modules or channels for advanced features. These 
features are generally embedded in the module in order to not use the resources of 
the PLC Controller and to allow a fast response time, depending of the feature. 
Regarding the function, it could be considered as a “stand alone” module, because 
the function is independent of the Controller processing cycle, it just exchanges 
some information with the Controller CPU.

F

FAST I/O
FAST I/Os are specific I/Os with some electrical features (response time, for 
example) but the treatment of these channels is done by the Controller CPU.

FAST task
The FAST task is a periodic, high-priority task of a short duration that is run on a 
processor through its programming software. The task fast speed keeps it from 
interfering with the execution of lower priority master (MAST) tasks. A FAST task is 
useful when fast periodic changes in discrete inputs need to be monitored.

FB
A function block performs a specific automation function, such as speed control, 
interval control, or counting. A function block comprises configuration data and a set 
of operating parameters.
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FBD
A function block diagram is a graphically oriented programming language, compliant 
with IEC 61131-3. It works with a list of networks whereby each network contains a 
graphical structure of boxes and connection lines which represents either a logical 
or arithmetic expression, the call of a function block, a jump, or a return instruction.

FDT
Field device tool for standardized communications between field devices and 
SoMachine.

FE
Functional ground is the point of a system or device that must be grounded to help 
prevent equipment damage.

FG
frequency generator

firmware
The firmware represents the operating system on a controller.

Flash memory
Flash memory is nonvolatile memory that can be overwritten. It is stored on a special 
EEPROM that can be erased and reprogrammed.

FTP
File transfer protocol is a standard network protocol (built on a client-server 
architecture), to exchange and manipulate files over TCP/IP based networks.

function
A function:

is a POU that returns 1 immediate result
is directly called with its name (as opposed to through an instance)
has no persistent state from one call to the next
can be used as an operand in expressions

Examples: boolean (AND) operators, calculations, conversions (BYTE_TO_INT)

function block (FB)
See FB.
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function block diagram (FBD)
See FBD.

FWD
forward

G

gross weight
Indication of the load weight on an instrument when no tare or predefining device 
has been used.

GVL
The global variable list manages global variables that are available in every 
application POU.

H

HE10
Rectangular connector for electrical signals with frequencies below 3MHz, 
complying with IEC60807-2.

HMI
A human-machine interface is an operator interface (usually graphical) for industrial 
equipment.

hot swapping
Hot swapping is the replacement of a component with a like component while the 
system remains operational. The replacement component begins to function 
automatically after it is installed.

HSC
high-speed counter

HVAC
Heating ventilation and air conditioning applications monitor and control indoor 
environments.
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I

I/O
input/output

I/O scan
An input/output scan continuously polls I/O modules to collect data bits and status, 
error, and diagnostics information. This process monitors inputs and controls 
outputs.

I/O terminal
An input/output terminal on the front of an expansion I/O module connects input and 
output signals.

ICMP
The internet control message protocol reports errors and provides information 
related to datagram processing.

IEC
The international electrotechnical commission is a non-profit and non-governmental 
international standards organization that prepares and publishes international 
standards for all electrical, electronic, and related technologies. 

IEC 61131-3
The IEC 61131-3 is an international electrotechnical commission standard for 
industrial automation equipment (like controllers). IEC 61131-3 deals with controller 
programming languages and defines 2 graphical and 2 textual programming 
language standards:

graphical: ladder diagram, function block diagram
textual: structured text, instruction list

IEEE
The institute of electrical and electronics engineers is a non-profit international 
standards and conformity assessment body for advances in all fields of 
electrotechnology.
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IEEE 802.3
IEEE 802.3 is a collection of IEEE standards defining the physical layer, and the 
media access control (MAC) sublayer of the data link layer, of wired Ethernet.

IL
A program written in the instruction list language is composed of a series of 
instructions executed sequentially by the controller. Each instruction includes a line 
number, an instruction code, and an operand. (IL is IEC 61131-3 compliant.)

immediate addressing
The direct method of addressing memory objects, including physical inputs and 
outputs, used in programming instructions as operands and parameters by using 
their direct address (for example, %Iwx or %QWx).

The use of immediate addressing in your program may avoid the need to create 
symbols for these objects, but there are also disadvantages. For example, if you 
change the program configuration by adding or deleting devices or I/O modules or 
slices, the immediate addresses used as programming instruction operands and/or 
parameters are not updated and must be corrected manually, which may cause 
extensive program modifications and lead to incorrect programming instructions. 
(See symbolic addressing.)

input filter
An input filter is a special function that rejects input noises. It is useful for eliminating 
input noises and chatter in limit switches. All inputs provide a level of input filtering 
using the hardware. Additional filtering with software is also configurable through the 
programing or the configuration software.

input terminal
An input terminal on the front of an expansion I/O module connects input signals 
from input devices (such as sensors, push buttons, and limit switches). For some 
modules, input terminals accept both sink and source DC input signals.

instruction list language (IL)
Refer to IL.

INT
A single integer is encoded in 16 bits.
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IP
The internet protocol is part of the TCP/IP protocol family that tracks the Internet 
addresses of devices, routes outgoing messages, and recognizes incoming 
messages.

IP 20
Ingress protection rating according to IEC 60529. IP20 modules are protected 
against ingress and contact of objects larger than 12.5 mm. The module is not 
protected against harmful ingress of water.

IP 67
Ingress protection rating according to IEC 60529. IP67 modules are completely 
protected against ingress of dust and contact. Ingress of water in harmful quantity is 
not possible when the enclosure is immersed in water up to 1m.

K

Kd
derivative gain

Ki
integral gain

Kp
proportional gain

L

Ladder Diagram language
See LD.

LAN
A local area network local area network is a short-distance communications network 
that is implemented in a home, office, or institutional environment.
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latching input
A latching input module interfaces with devices that transmit messages in short 
pulses. Incoming pulses are captured and recorded for later examination by the 
application.

LCD
liquid crystal display

LD
A program in the ladder diagram language includes a graphical representation of 
instructions of a controller program with symbols for contacts, coils, and blocks in a 
series of rungs executed sequentially by a controller. IEC 61131-3 compliant.

LED
A light emitting diode is an indicator that lights up when electricity passes through it.

LINT
Long integer is a 64-bit variable (4 times INT or two times DINT).

LMC
lexium motion control

load receiver device
Part of instrument that will receive the load.

located variable
A located variable has an address. (See unlocated variable.)

LRC
longitudinal redundancy checking

LREAL
Long real is a 64-bit variable.
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LSB
The least significant bit (or least significant byte) is the part of a number, address, or 
field that is written as the right-most single value in conventional hexadecimal or 
binary notation.

LWORD
A long word type is encoded in a 64-bit format.

M

MAC address
The media access control address is a unique 48-bit number associated with a 
specific piece of hardware. The MAC address is programmed into each network 
card or device when it is manufactured.

Machine
A Machine consists of several functions and/or equipments which build the machine.

Magelis
Magelis is the commercial name for Schneider Electric’s range of HMI terminals.

MAST
A master (MAST) task is a processor task that is run through its programming 
software. The MAST task has two sections:

IN: Inputs are copied to the IN section before execution of the MAST task.
OUT: Outputs are copied to the OUT section after execution of the MAST task.

master/slave
The single direction of control in a network that implements the master/slave model 
is always from a master device or process to one or more slave devices.

maximum weight
Maximum measuring capacity, not taking account of the additive capacity of the tare.

MIB
The management information base is an object database that is monitored by a 
network management system like SNMP. SNMP monitors devices that are defined 
by their MIBs. Schneider has obtained a private MIB, groupeschneider (3833).
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minimum I/O update time
The minimum I/O update time is the minimum time it takes for the bus cycle to shut 
down to force an I/O update at each cycle.

minimum weight
Load value under which measuring results can be marred by a relative detected 
error that is too large.

Modbus
The Modbus communication protocol allows communications between many 
devices connected to the same network. 

Modbus SL
Modbus serial line

MSB
The most significant bit (or most significant byte) is the part of a number, address, 
or field that is written as the left-most single value in conventional hexadecimal or 
binary notation.

N

NAK
negative acknowledge

NC
A normally closed contact is a contact pair that is closed when the actuator is de-
energized (no power is applied) and open when the actuator is energized (power is 
applied).

NEC
The national electric code dictates the safe installation of electrical wiring and 
equipment.
138 04/2012



Glossary
NEMA
The national electrical manufacturers association publishes standards for the 
performance of various classes of electrical enclosures. The NEMA standards cover 
corrosion resistance, ability to protect from rain and submersion, etc. For IEC 
member countries, the IEC 60529 standard classifies the ingress protection rating 
for enclosures.

net weight (net)
Weight indication of a load placed on an instrument after a tare device has been 
used.

Net weight = Gross weight - Tare weight

network
A network includes interconnected devices that share a common data path and 
protocol for communications.

Nibble
A Nibble is a half-byte (representing 4 bits of a byte).

NMT
Network management protocols provide services for network initialization, error 
control, and device status control.

NMT state machine
A network management state machine defines the communication behavior of any 
CANopen device. The CANopen NMT state machine consists of an initialization 
state, a pre-operational state, an Operational state, and a stopped state. After 
power-on or reset, the device enters the initialization state. After the device 
initialization is finished, the device automatically enters the pre-operational state and 
announces the state transition by sending the boot-up message. In this manner, the 
device indicates that it is ready to work. A device that stays in pre-operational state 
may start to transmit SYNC-, Time Stamp-, or Heartbeat message. In this state, the 
device can not communicate through a PDO; it must do so with an SDO. In the 
operational state, the device can use all supported communication objects.

NO
A normally open contact is a contact pair that is open when the actuator is de-
energized (no power is applied) and closed when the actuator is energized (power 
is applied).
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node
A node is an addressable device on a communication network.

O

ODVA
The open deviceNet vendors association supports the family of network 
technologies that are built on CIP (EtherNet/IP, DeviceNet, and CompoNet).

OS
Operating system. Can be used for Firmware that can be uploaded/downloaded by 
the user.

OSI
The open system interconnection reference model is a 7-layer model that describes 
network protocol communications. Each abstract layer receives services from the 
layer below it and provides services to the layer above.

OTB
Optimized terminal block, used in the context of Advantys I/O distributed module

output terminal
An output terminal connects output signals to output devices (such as electrome-
chanical relays and solenoid valves).

P

pallet
A pallet is a portable platform, which is used for storing or moving goods.

PCI
A peripheral component interconnect is an industry-standard bus for attaching 
peripherals.

PDM
A power distribution module distributes either AC or DC field power to a cluster of 
I/O modules. 
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PDO
A process data object is transmitted as an unconfirmed broadcast message or sent 
from a producer device to a consumer device in a CAN-based network. The transmit 
PDO from the producer device has a specific identifier that corresponds to the 
receive PDO of the consumer devices. 

PDU
protocol data unit

PE
Protective ground is a return line across the bus for fault currents generated at a 
sensor or actuator device in the control system.

periodic execution
The master task is executed either cyclically or periodically. In periodic mode, you 
determine a specific time (period) in which the master task must be executed. If it is 
executed under this time, a waiting time is generated before the next cycle. If it is 
executed over this time, a control system indicates the overrun. If the overrun is too 
high, the controller is stopped.

persistent data
Value of persistent data that will be used at next application change or cold start. 
Only get re-initialized at a reboot of the controller or reset origin. Especially they 
maintain their values after a download.

PI
proportional integral

PID
proportional, integral and derivative control

PLC
The programmable logic controller is the “brain” of an industrial manufacturing 
process. It automates a process, used instead of relay control systems. PLCs are 
computers suited to survive the harsh conditions of the industrial environment.
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PLCopen
The PLCopen standard brings efficiency, flexibility, and manufacturer independence 
to the automation and control industry through the standardization of tools, libraries, 
and modular approaches to software programming.

PLI
pulse latch input

post-configuration
Post-configuration files contain machine-independent parameters, including:

machine name
device name or IP address
Modbus serial line address
routing table

POU
A program organization unit includes a variable declaration in source code and the 
corresponding instruction set. POUs facilitate the modular reuse of software 
programs, functions, and function blocks. Once declared, POUs are available to one 
another. SoMachine programming requires the utilization of POUs.

POU FB
Program organization unit function block types are user programs that can be 
defined by the user in the ST, IL, LD, or FBD languages. You can use POU FB types 
in an application to:

simplify the design and entry of the program
make the program easier to read
simplify debugging
reduce the amount of generated code

power supply terminals
The power supply is connected to these terminals to provide power to the controller.

Profibus DP
Profibus Decentralized Peripheral

An open bus system that uses an electrical network based on a shielded 2-wire line 
or an optical network based on a fiber-optic cable. DP transmission allows for high-
speed, cyclic exchange of data between the controller CPU and the distributed I/O 
devices.
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protocol
A protocol is a convention or standard that controls or enables the connection, 
communication, and data transfer between two computing endpoints.

Pt100/Pt1000
Platinum resistance thermometer are characterized by their nominal resistance R0 
at a temperature of 0°  C.

Pt100 (R0 = 100 Ohm)
Pt1000 (R0 = 1 kOhm)

PTO
Pulse train outputs are used to control for instance stepper motors in open loop.

PWM
Pulse width modulation is used for regulation processes (e.g. actuators for 
temperature control) where a pulse signal is modulated in its length. For these kind 
of signals, transistor outputs are used.

R

RAM
random access memory

REAL
Real is a numeric data type. The REAL type is encoded in a 32-bit format.

real-time clock (RTC)
See RTC

reflex output
In a counting mode, the high speed counter current value is measured against its 
configured thresholds to determine the state of these dedicated outputs.

retained data
A retained data value is used in the next power-on or warm start. The value is 
retained even after an uncontrolled shutdown of the controller or a normal switch-off 
of the controller.
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RFID
Radio-frequency identification is an automatic identification method that relies on 
the storage and remote retrieval of data using RFID tags or transponders.

RJ-45
This registered jack is a modular connector that is commonly implemented in 
communication networks.

RPDO
A receive PDO sends data to a device in a CAN-based network.

RPM
revolutions per minute

RPS
revolutions per second

RS-232
RS-232 (also known as EIA RS-232C or V.24) is a standard type of serial 
communication bus, based on three wires.

RS-485
RS-485 (also known as EIA RS-485) is a standard type of serial communication bus, 
based on two wires.

RTC
The real-time clock option keeps the time for a limited amount of time even when the 
controller is not powered.

RTS
Request to send is a data transmission signal and will be acknowledged by the CTS 
signal from the destination node.

RTU
A remote terminal unit is a device that interfaces with objects in the physical world 
to a distributed control system or SCADA system by transmitting telemetry data to 
the system and/or altering the state of connected objects based on control 
messages received from the system.
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RxD
receiving data (data transmission signal)

S

SCADA
A supervisory control and data acquisition system monitors, manages, and controls 
industrial applications or processes.

scale division
Value in mass units, expressing the difference between two consecutive indications 
for one numerical indication.

scan
A controller scanning program performs 3 basic functions: [1] It reads inputs and 
places these values in memory; [2] it executes the application program 1 instruction 
at a time and stores results in memory; [3] It uses the results to update outputs.

SDO
A service data object message is used by the field bus master to access (read/write) 
the object directories of network nodes in CAN-based networks. SDO types include 
service SDOs (SSDOs) and client SDOs (CSDOs).

SEL-V
A system that follows IEC 61140 guidelines for safety extra low voltage is protected 
in such a way that voltage between any 2 accessible parts (or between 1 accessible 
part and the PE terminal for Class 1 equipment) does not exceed a specified value 
under normal conditions or under single-fault conditions.

Sequential Function Chart
See SFC.

SFC
A program written in the sequential function chart language can be used for 
processes that can be split into steps. SFC is composed of steps with associated 
actions, transitions with associated logic condition, and directed links between steps 
and transitions. (The SFC standard is defined in IEC 848. It is IEC 61131-3 
compliant.)
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sink input
A sink input is a wiring arrangement in which the device provides current to the input 
electronic module. A sink input is referenced to 0 Vdc.

SINT
Signed integer is a 16-bit value.

SL
serial line

SMS
The short message service is a standard communication service for telephones (or 
other devices) that send short text messages over the mobile communications 
system.

SNMP
The simple network management protocol can control a network remotely by polling 
the devices for their status, performing security tests, and viewing information 
relating to data transmission. It can also be used to manage software and databases 
remotely. The protocol also permits active management tasks, such as modifying 
and applying a new configuration

source output
A source output is a wiring arrangement in which the output electronic module 
provides current to the device. A source output is referenced to +24 Vdc.

SSI
Serial synchronous interface is a common interface for relative and absolute 
measurement systems like encoders.

ST
See structured text.

STN
Scan Twisted Nematic (also known as passive matrix)

STRING
A STRING variable is a series of ASCII characters.
146 04/2012



Glossary
Structured Text
A program written in the structured text (ST) language includes complex statements 
and nested instructions (such as iteration loops, conditional executions, or 
functions). ST is compliant with IEC 61131-3.

symbol
A symbol is a string of a maximum of 32 alphanumeric characters, of which the first 
character is alphabetic. It allows you to personalize a controller object to facilitate 
the maintainability of the application.

symbolic addressing
The indirect method of addressing memory objects, including physical inputs and 
outputs, used in programming instructions as operands and parameters by first 
defining symbols for them using these symbols in association with the programming 
instructions.

In contrast to immediate addressing, this is the recommended method because if the 
program configuration changes, symbols are automatically updated with their new 
immediate address associations, whereas any immediate addresses used as 
operands or parameters are not. (See immediate addressing.)

system time
An internal clock provides a device with the system time.

system variable
A system variable structure provides controller data and diagnostic information and 
allows sending commands to the controller.

T

TAP
A terminal access point is a junction box connected to the trunk cable that allows you 
to plug in drop cables.

tare
Load placed on the load receiver along with the product to be weighed.
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tare device
Device allowing the instrument indication to be moved to zero when a load is 
positioned on the load receiver:

tare predefining device
Device allowing a predefined tare value to be subtracted from a gross weight value 
and indicating the result of the calculation. The load range is consequently reduced.

Tare Value
Weight value of a load, determined by a tare full-bridge strain gauge electronic 
module.

taring
Action allowing the instrument indication to be moved to zero when a load is 
positioned on the load receiver.

task
A group of sections and subroutines, executed cyclically or periodically for the MAST 
task, or periodically for the FAST task.

A task possesses a level of priority and is linked to inputs and outputs of the 
controller. These I/O are refreshed in consequence.

A controller can have several tasks.

TCP
A transmission control protocol is a connection-based transport layer protocol that 
provides a reliable simultaneous bi-directional transmission of data. TCP is part of 
the TCP/IP protocol suite.

terminal block
The terminal block is the component that mounts in an electronic module and 
provides electrical connections between the controller and the field devices.

TFT
thin film transmission (also known as active matrix)

threshold output
Threshold outputs are controlled directly by the HSC according to the settings 
established during configuration.
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TP
A touch probe is a position capture that is triggered by a fast input signal (quick 
sensor). On the rising edge of the touch probe input the position of an encoder is 
captured. Example: This is used for packaging machines to capture the position of 
a printmark on a film to cut always on the same position.

TPDO
A transmit PDO reads data from a device in a CAN-based system.

trunk cable
A trunk cable is the main cable that is terminated at both physical ends with line 
termination resistors.

TVDA
tested validated documented architectures

TxD
TxD represents a transmit signal.

U

UDINT
An unsigned double integer is encoded in 32 bits.

UDP
The user datagram protocol is a connectionless mode protocol (defined by 
IETF RFC 768) in which messages are delivered in a datagram (data telegram) to a 
destination computer on an IP network. The UDP protocol is typically bundled with 
the Internet Protocol. UDP/IP messages do not expect a response, and are 
therefore ideal for applications in which dropped packets do not require 
retransmission (such as streaming video and networks that demand real-time 
performance).

UINT
An unsigned integer is encoded in 16 bits.
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UL
Underwriters Laboratories, US organization for product testing and safety 
certification.

unlocated variable
An unlocated variable does not have an address. (See located variable.)

UTC
coordinated universal time

V

VSD
variable speed drive

W

WORD
The WORD type is encoded in a 16-bit format.
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